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Introduction
Thank you very much for your purchase of this Toshiba Pocket PC e400/
e405.
Please be sure to read this user’s guide before using the Toshiba Pocket
PC e400/e405, and ensure that you are aware of correct the handling pro-
cedures. 
• Please be sure to read the “Safety precautions” section in this docu-

ment to learn about important safety issues.
• After reading this document, keep it in a convenient place for future

reference.

Copyright Information
© 2003 by Toshiba Corporation. All rights reserved. Under the copyright
laws, this manual cannot be reproduced in any form without the prior writ-
ten permission of Toshiba. No patent liability is assumed, with respect to
the use of the information contained herein.

Microsoft®, Windows®, ActiveSync®, and PowerPoint® are registered
trademarks, and Windows CE™ is a trademark, of Microsoft Corporation
in the United States and other countries.

The names of other actual companies, products, and brand names men-
tioned herein may be trade names, service marks, trademarks, or regis-
tered trademarks of their respective owners.

First Edition    September 2003

All rights reserved.

Toshiba Pocket PC e400/e405 User’s Guide
First edition September 2003

Trademarks
Microsoft, ActiveSync, Outlook, Pocket Outlook, Windows, Windows
Mobile, Windows CE, and the Windows logo are either registered trade-
marks or trademarks of Microsoft Corporation in the United States and/or
other countries. Microsoft products are licensed to OEMs by Microsoft
Licensing, Inc., a wholly owned subsidiary of Microsoft Corporation.

Safety precautions
• Please carefully read “Safety precautions” before using the Toshiba

Pocket PC e400/e405 and ensure that you are aware of correct han-
dling procedures.
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• The precautions  provide essential information for the protection of the
user and others from possible injury and property damage.  They also
provide information on the safe handling of this product.

• Please check that you fully understand the definition of the following
messages (signs and graphical symbols) before  reading the text, and
always follow the instructions provided.

Safety instructions
All safety instructions must be read carefully and must be fully under-
stood, before attempting to use your Toshiba Pocket PC e400/e405. This 
manual contains the safety instructions that must be observed in order to 
avoid potential hazards that could result in personal injuries or could dam-
age your computer. The safety instructions have been classified accord-
ing to the seriousness of the risk, as follows:

Always request and obtain prior consent and approval of an authorized
airline representative before using your Pocket PC aboard an aircraft.
Always follow the instructions of the airline representative whenever using
your Pocket PC aboard an aircraft, to prevent any possible interference
with airborne electronic equipment. Your Pocket PC produces low levels
of RF energy due to the generation of digital timing pulses by its clock
oscillator circuits. Your Pocket PC has been equipped with internal shield-
ing to minimize any stray emissions of RF energy. Airlines may neverthe-
less prohibit the on-board use of all portable PCs (and all other portable
electronic devices that could potentially emit stray RF energy), particularly

Signal Word Meaning

Indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.

Indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

Indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

Indicates a potentially hazardous situation which, if not
avoided, may result in property damage.

Provides important information.
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during take-offs and landings, to prevent any possible interference with
the reception of signals by airborne electronic navigational devices.

Certain locations, such as hospitals, may restrict the use of Pocket PCs
and other devices that emit low-level RF energy.

Always comply was posted prohibitions of the use of RF-emitting devices,
such as in hospitals. Failure to follow such directives could result in the
interference with medical equipment and/or devices.

Never come closer than 16 cm (6 inches) to a person with a heart pace-
maker implant when using this Pocket PC in combination with a mobile
cellular telephone. Failure to do so could result in interference with the
function of the pacemaker.

Never use a Pocket PC while driving an automobile or any other moving
vehicle. Always pull out of traffic and come to a stop in a legally permissi-
ble and safe location before using your Pocket PC. Failure to do so could
result in serious bodily injury in a traffic accident.

Never use your Pocket PC while walking. Usage while walking could
result in bodily injury caused by inattention to automobile traffic or other
pedestrian hazards.

Never allow metallic objects, such as staples and paper clips, to enter
inside your Pocket PC. Metallic objects, such as staples and paper clips, if
allowed to enter your Pocket PC, could cause the generation of excess
heat or fire.

Never connect terminals (metal parts) to metallic objects (such as wires).
Connecting terminals to metal objects could cause excessive heat or fire.

Always immediately turn the battery switch to the “off” position and dis-
connect the AC Adaptor from the power outlet in the event the Pocket PC
emits an unusual odor or sound or generates smoke.

Never use or store your Pocket PC in the following locations:

Anywhere it may be exposed to water, such as a bathroom or sauna;

In conditions of high humidity, such as in the rain or fog; Where your
Pocket PC will be exposed to high temperatures, such as near a fire or
equipment that emits high temperatures; In direct sunlight; or In a sealed
automobile left in the sun and subject to high temperatures.
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Never drop your Pocket PC or subject it to severe shock. Dropping your
Pocket PC or subjecting it to severe shock could cause the battery to
leak, ignite and/or rupture.

Always immediately remove your Pocket PC a from the vicinity of any
open flame in the event the battery leaks liquid or emits an unusual odor.
Continued use of your Pocket PC under either of these conditions could
cause ignition (i.e., fire) of the leaked battery liquid, or rupture.

Never touch any fluid that might leak from the battery. Such liquid when in
contact with the eyes or skin, could cause injury to the skin or eyes.
Should the liquid come into contact with the eyes, irrigate the eyes thor-
oughly with clean water and immediately seek medical attention. In the
event the liquid comes into contact with the skin or clothing, wash it away
immediately with clean water.

Never attempt to disassemble, repair or make any modification to your
Pocket PC. Disassembly, modification or any attempt at repair could
cause bodily injury or property damage, as well as damage to the Pocket
PC itself.

Failure to follow the above directions concerning use and storage could
result in damage to your Pocket PC or bodily injury and property damage
due to battery liquid leakage, fire, or rupture.

Never raise the sound volume level to high when using your Pocket PC
with earphones. An excessive sound volume level could cause damage to
your hearing.

Never touch the liquid that might leak from a broken liquid crystal display.
Contact with this liquid could cause a skin rash. If the crystal display liquid
should come into contact with the skin or clothing, wash it immediately
with clean water.

Never allow infants or small children within reach of your Pocket PC.
Infants or small children could injure themselves if allowed access to your
Pocket PC.

Never attempt to disassemble or repair an AC Adaptor, and never alter
their Power Supply Cables or plugs as exposure to electric shock hazards
could result.

Always contact an authorized service provider, if repair or replacement is
required.
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Always use the AC Adaptor  that has  been provided with your Pocket PC.

Bodily injury or property damage could occur as a result of the use of an
unauthorized and incompatible AC Adaptor  in violation of this Warning.

Never connect or disconnect the AC Adaptor with wet hands. Connecting
or disconnecting the AC Adaptor to a power source with wet hands could
cause electric shock.

Never attempt to connect or disconnect the power plug with damp or wet
hands. Connecting or disconnecting the power plug with damp or wet
hands could result in an electric shock.

Never  leave an open container, such as a cup or glass, containing a liq-
uid near the AC Adaptor. Spilled liquid coming in contact with the AC
Adaptor could cause a fire or electric shock.

Always ensure the power plug pins are clean and free of dust or other for-
eign material by wiping the pins with a clean dry cloth. Dust or other for-
eign material accumulation on the power plug pins could cause fire.

Always unplug the power plug from an outlet by grasping the power plug
itself. Never pull on the Power Supply Cable to disconnect the Power
Supply Cable from an outlet. Pulling on the Power Supply Cable could
cause a fire or electric shock as a result of damage to the Power Supply
Cable.

Never use a worn or damaged AC Adaptor Power Supply Cable or plug,
or a worn or damaged extension cord or plug. The use of a worn or dam-
aged Power Supply Cable or plug could result in electric shock or fire.
Always contact an authorized service provider immediately to obtain a
suitable Power Supply Cable replacement.

Never place an AC Adaptor on a wooden surface (or any other surface
that could be marred by exposure to heat) while it is in use, since its sur-
face temperature increases during normal use. Always rest it on a suitable
heat-insulating material.

Never cover the AC Adaptor with any object while it is in use, and never
place it adjacent to a heat source. An excessive temperature increase
could detrimentally affect its performance.

Never place a Power Supply Cable near a heat source, as damage to the
cord or to its insulation could result.
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Always use a surge protector when utilizing the AC Adaptor during an
electrical storm. Otherwise, a power surge could result in the loss of
stored data.

Insert the power plug to a household electric outlet.

When travelling abroad, never plug the AC Adaptor into a power source
that does not correspond to both the voltage and the   frequency specified
on the rating plate of the unit, as equipment damage will result.

Never bend or twist a Power Supply Cable, and never pull on a Power
Supply Cable in an attempt to remove a plug from an outlet. Always grasp
the plug directly when unplugging a Power Supply Cable to avoid causing
any damage to the cord.

Never plug the AC Adaptor into an overloaded multiple outlet, power strip
or surge protector to prevent blowing a fuse or tripping a circuit breaker.

Never place heavy objects on a Power Supply Cable, as that could result
in damage to the cord.

Always confirm that the AC Adaptor plug (and the extension cord
and plug, if any) have been fully inserted into the receptacle, to
assure a secure electrical connection.

Under certain conditions, data may be lost, including:

Misuse of your Pocket PC; Subjecting the main unit of your Pocket PC to
static electricity and/or noise; Total loss of electric charge in the battery;
and Servicing of your Pocket PC.

Avoid connecting your Pocket PC to an external device such as a com-
puter in an environment likely to be affected by static electricity. For exam-
ple during low-humidity weather, shuffling your shoes upon a rag can
produce static electricity. Before you handle your computer, you should
touch a grounded object  to discharge any static electricity from your body. 

Avoid using your Pocket PC in environments that are likely to be affected
by static electricity or are prone to high electrical noise. If you connect
your Pocket PC to a computer via the optional docking cradle for data
transfer or data restoration purposes, Toshiba will not be responsible for
any Pocket PC or computer malfunction, problems with data transfer or
data modifications/loss that may occur in these environments. 

Use your Pocket PC only in locations with the following ambient environ-
mental conditions: 
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Under normal operational use with temperatures between 0°C and 40°C
(32°F and 104°F); With humidity of 30% to 80%; and When charging the
battery with temperatures between 5°C and 40°C (41°F and 104°F).

Do not store or use your Pocket PC in the following locations:

Those subject to extremely high or low temperatures; Dusty locations;
and Locations or sites subject to strong vibration.

Use or storage in these location, sites or areas can result in product fail-
ure, malfunction or loss of data.

Do not subject your Pocket PC to sudden and severe temperature
changes. This could result in moisture condensation in the Pocket PC that
could cause damage to your Pocket PC, computer function loss, and/or
the loss of data. In the event of moisture condensation, allow your Pocket
PC to dry out completely.

It is normal for the AC Adaptor to become warm when charging.

Disconnect the power plug from the outlet when not in use.

Take care not to sit on your Pocket PC when it is located in the back
pocket of trousers, etc. This could cause damage to your Pocket PC or
malfunction of the Pocket PC functions.

Do not place objects on top of your Pocket PC or drop them on top of your
Pocket PC. This could cause damage to your Pocket PC and/or malfunc-
tion.

Clean terminals (metallic parts) on a regular basis with a cotton swab.
Dirty terminals could affect battery charging.

Never use organic solvents such as benzene or paint thinner to clean
your Pocket PC. Use of these solvents can cause deformation or discolor-
ation.

Do not wipe the display with a damp or wet cloth or touch the display with
damp or wet hands. Wiping or touching the display under this condition
can cause product failure or malfunction. Always use a soft dry cloth to
wipe the display.

When using the SD memory card, be sure to read the relevant
instruction manual and ensure that you know the proper procedures
for their use.
Never  subject the card to any severe shock while connected to your
Pocket PC. Such a shock can cause damage to the card and a malfunc-
tion.

Do not carry your Pocket PC with the card connected to it. This can result
in the damage or loss of the card.
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Never connect the optional cradle terminals with metallic objects, such as
wires. Connecting these terminals with metallic objects may cause the
production of excess heat, burns and damage to the charger and/or your
Pocket PC.

Lithium-Ion batteries are recyclable. Never dispose of the battery with
ordinary waste.

Never bend or twist your Pocket PC. This could cause damage to your
Pocket PC or malfunction of the Pocket PC functions.

Working environment
This product was designed to fulfill the EMC (electromagnetic compatibil-
ity) requirements for “residential, commercial and light industry environ-
ments”.
Toshiba does not approve the use of this product in working environments
other than “residential, commercial and light industry environments”.
For example, the following environments are not recommended:
• Industrial Environments (environments with a main voltage >230V~)
• Medical Environments

Supplementary Information: “The product complies with the
requirements of the Low Voltage
Directive 73/23/EEC and the EMC
Directive 89/336/EEC.”

Weitere Informationen: “Das   Produkt   entspricht  den
Anforderungen  der Niederspan-
nungs Richtlinie 73 23/EG und   der
EMC-Richtlinie 89/336/EG.”

Informations complérnentaires: “Ce produit est conforme aux exi-
gences de la directive sur les
basses tensions 73/23/CEE et de la
directive EMC 89/336/CEE.”

Información complementaria: “El Producto cumple los requistos
de baja tensión de la Directiva 73/
23/CEE y la Directiva EMC 89/336/
CEE.”

Ulteriori informazioni: “Il prodotto é conforme ai requisiti
della direttiva sulla bassa tensione
73/23/EG e la direttiva EMC 89/
336/EG.”

Ytterligare information: “Produkten uppfyller kraven enligt
lägspänningsdirektiver 73/23/EEC
och EMC-direktiv 89/336/EEC.”
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• Automotive Environments
• Aircraft Environments
Any consequences resulting from the use of this product in working envi-
ronments that are not approved are not the responsibility of Toshiba Cor-
poration.
The consequences of the use of this product in non-approved working
environments may be: 
• Interference with other devices or machines in the nearby surrounding

area
• Malfunction of, or data loss from, this product caused by disturbances

generated by other devices or machines in the nearby surrounding
area

Therefore Toshiba strongly recommends that the electromagnetic com-
patibility of this product be suitably tested in all non-approved working
environments before use. In the case of automobiles or aircraft, the man-
ufacturer or airline respectively should be asked for permission before use
of this product.
Furthermore, for general safety reasons, the use of this product in envi-
ronments with explosive atmospheres is not permitted.

CE compliance
This product and the original options are designed to observe the related
EMC (Electromagnetic compatibility) and safety standards. However,
Toshiba cannot guarantee that this product still observes these EMC stan-
dards if options or cables not produced by Toshiba are connected or
implemented. In this case the persons who have connected/implemented
those options/cables have to make sure that the system (PC plus options/
cables) still fulfils the required standards. To avoid general EMC prob-
lems, the following advice should be observed:
• Only CE marked options should be connected/implemented
• Only best shielded cables should be connected

FCC Notice 
“Declaration of Conformity”
This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interfer-
ence in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accor-
dance with the instructions, may cause harmful interference to radio com-
munications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
10



interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is subject
to the following two conditions:
1. This device may not cause harmful interference

2. This device must accept any interference received, including interfer-
ence that may cause undesired operation.

Canadian Regulatory Information 
(Canada Only)
This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus as set out in the Radio Interference Reg-
ulation of the Canadian Department of Communications.
Note that Canadian Department of Communications (DOC) regulations
provide, that changes or modifications not expressly approved by
TOSHIBA Corporation could void your authority to operate this equip-
ment.
This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.
Cet appareil numérique de la class B respecte toutes les exgences du
Règlement sur le matériel brouilleur du Canada.

Only peripherals complying with the FCC class B limits
may be attached to this equipment. Operation with non-
compliant peripherals or peripherals not recommended
by Toshiba is likely to result in interference to radio and
TV reception. Shielded cables must be used between the
external devices and the computer’s USB ports, external
monitor port, PS/2 keyboard port and PS/2 mouse
port.Changes or modifications made to this equipment,
not expressly approved by Toshiba or parties authorized
by Toshiba could void the user’s authority to operate the
equipment.
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 VCCI Notice
(Japan Only) Class BITE
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FCC Class B Digital Devices & Peripheral 
Devices (Declaration of Conformity or 
Certification Authorization)

Declaration of Conformity Label & Marking 
Requirements
• User Manual must provide user information in accordance with

±15.19(a)(3), 15.21, 15.27 and 15.105(b):

Instruction Manual Federal 
Communication Commission 
Interference Statement

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interfer-
ence in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accor-
dance with the instructions, may cause harmful interference to radio com-
munications.
However, there is no guarantee that interference will not occur in a partic-
ular installation. If this equipment does cause harmful interference to radio
or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one
of the following measures:
• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Assure continued compliance (for example, use only
shielded interface cables when connecting to computer or peripheral
devices). Any changes or modifications not expressly approved by the
manufacturer of this device could void the user's authority to operate
this equipment.
This device complies with Part 15 of the FCC Rules. Operation is sub-
ject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.
Responsible Party: Toshiba America Information Systems, Inc.
 9740 Irvine Blvd.
                           Irvine, CA 92618-1697
Telephone Number: 1-800-Toshiba
13
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Chapter 1: Getting Started
Chapter 1:

Getting Started

Welcome
Congratulations on purchasing your Toshiba Pocket PC e400/e405. Due
to the size and capabilities of this device, you can keep your most impor-
tant business and personal information up-to-date and close at hand.
Microsoft® ActiveSync® increases the power of your device by allowing
you to synchronize the information on your desktop or laptop computer
with your device. 
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Toshiba Pocket PC e400/e405
Where to Find Information
This book describes your Pocket PC hardware, provides an overview of
the programs on your Pocket PC, and explains how to connect your
Pocket PC to a computer. For instructions on setting up your Pocket PC
and installing ActiveSync, see below.

For programs on your Pocket PC See this source:

Programs on your Pocket PC This user's manual and device Help.

Connecting to and synchronizing with a 
computer

The Quick Start Card or ActiveSync Help on 
your computer. To view Help, click Help and 
then Microsoft ActiveSync Help.

Last-minute updates and detailed technical 
information

The Read Me files, located in the Microsoft 
ActiveSync folder on the computer and on the 
Pocket PC Companion CD.

Up-to-date information on your Toshiba 
Pocket PC e400/e405 

http://www.pda.toshiba.com
16



Chapter 2: Basic Skills
Chapter 2:

Basic Skills
Your Toshiba Pocket PC e400/e405 is easy to learn how to use. This
chapter describes the use and customization of your
Toshiba Pocket PC e400/e405.

Parts Names and Function

Main unit (front view)

Cursor Button/ 

Navigation Button

Speaker

Touch screen

Power Button/Screen light

Infrared Port

Recording Button

(Program Button 5)

Hold Switch

Stereo headphone jack

DC-IN socket Battery Switch

SD card slot

TOSHIBA Scroller

Cradle connection 

port

Battery LED

Program Buttons 1, 2, 3 & 4

Switch cover

Initial Setting of User 
Programmable Button
Program button 1 = Calendar  

Program button 2 = Tasks  

Program button 3 = Home  

Program button 4 = Contacts  
Program button 5 = Voice Recorder
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Toshiba Pocket PC  e400/e405 User’s Guide
Cradle (Optional)

Main unit (back view)

Recording Button

(Program Buttons)

Power Button/

Screen Light

Stylus

Stylus holder

TOSHIBA Scroller

SD card slot

DC-IN socket

Reset Button

Cradle (optional)

Hold Switch

Stereo Headphone Jack
18



Chapter 2: Basic Skills
Power Button
The power button turns the unit and the screen light on and off.

Battery Switch

The battery switch supplies/cuts off the battery power to the Toshiba
Pocket PC e400/e405.

The setting of this switch at shipment is “stop”. When using the Toshiba
Pocket PC e400/e405 for the first time, open the switch cover, then slide
this switch to the left (the “supply” side) with the stylus.

To turn on the battery switch:
1. Open Switch cover.

2. Slide the battery switch to the right.

Battery Alarm LED
The alarm LED indicates the following conditions.

Power button When the power is off When the power is on

Press and hold. The power turns on. The screen light alternately 
turns on/off.

Press it quickly. The power turns on. The power turns off.

Switching the battery switch to the "stop" position at any
time will lead to loss of data.

Flashing orange When the preset alarm time, which was set through Cal-
endar or Tasks, goes off, the lamp flashes.

Orange Indicates charging of the battery. 

Yellow The battery charging process is stopped due to the 
ambient temperature being too high or low. Charge the 
battery in an ambient temperature of approx. 41°F to 
104°F (5°C to 40°C).

Battery Switch

  
Supply  Stop Switch cover
19
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How to Use the Stylus
The stylus is used for menu selection or data input on the touch-screen of
the Toshiba Pocket PC e400/e405.

■ Tap: Touch the screen once with the stylus to open items and select
options.

■ Drag: Hold the stylus on the screen and drag it across to select text
and images. Drag in a list to select multiple items.

■ Tap and hold: Tap and hold the stylus on an item to see a list of
actions available for that item. On the pop-up menu that appears, tap
the action you want to perform.

About the Cursor Button
There are 2 modes for cursor button control, 

• 4-direction (upper, lower, right or left) 

• 8-direction (oblique angles are added).

You can select the either of these two modes by tapping Settings, and
then Buttons. In either mode, you can move a cursor (selection display)
on the screen by pressing the upper, lower, right, or left part of the cursor
button. You can select a program to launch by pressing the center part of
the cursor button.

About the Scroller
You can move the cursor on the screen by moving the scroller up and
down, as well as launching a program by pressing the scroller.

Green Indicates full charge of the battery.

When you operate the touch screen of the Toshiba
Pocket PC e400/e405, use the supplied stylus.

If the tip of the stylus is damaged, do not use it. If you
operate the touch screen with a damaged stylus or a ball-
point pen, the touch screen may be damaged.

When the stylus is damaged, please purchase a new
one.

Flashing orange When the preset alarm time, which was set through Cal-
endar or Tasks, goes off, the lamp flashes.
20



Chapter 2: Basic Skills
You can also activate the previous window by holding down the scroller
until the current window closes. To enable or disable this function, select
the mode by tapping Settings, and then Buttons. 

Hold Switch
When the Hold switch is on, Program Buttons 1 through 5, Cursor Button,
and Scroller will be disabled. The Hold switch icon will be displayed
o the navigation bar. On the contrary, when the Hold switch is off, these
buttons will be enabled again.

Flash ROM Disk (NAND Flash Memory)
The Flash ROM Disk (NAND Flash Memory) contains the built-in storage
for the Pocket PC.

Data, files or programs can be stored on the Flash ROM Disk from the fol-
lowing sources: File Explorer, Pocket Word, Pocket Excel, Notes of
Pocket Outlook, and DataBackup.

Data can be accessed on the Flash ROM Disk by using File Explorer.

1. On the Start menu, tap Programs, and then File Explorer.
2. Open Local Device folder, and then tap Flash ROM Disk.

To confirm the memory available on the Flash ROM Disk, do the following:

1. On the Start menu, tap Settings, System tab, and then Memory.

2. Tap the Storage Card tab, and then select Flash ROM Disk.

To store data from Pocket Word, Pocket Excel or Notes of Pocket Out-
look, open the application and do the following:

1. Select a location for storage by tapping Tools, Options, and then
select either SD Card or Flash ROM Disk. 

The cursor movement is different depending on the
screen. When the cursor is at the right or the left side of
the screen, it may not move.

Hold Switch

Off

On
21
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2. Tap OK.

Data stored on the Flash ROM Disk are not backed up. See "Using
DataBackup" on page 89. for information on how to make a backup of
data on the Flash ROM Disk. Periodic backups of data stored on the
Flash ROM Disk is recommended.

Battery Charging
A built-in battery is installed in the Toshiba Pocket PC e400/e405. When
using the Toshiba Pocket PC e400/e405 for the first time, set the battery
switch to the supply side, and then charge the built-in battery with the sup-
plied AC adapter.

Assembling the Optional Cradle
Prior to charging the battery, the back plate that supports the Toshiba
Pocket PC e400/e405 while charging needs to be inserted into the base
of the cradle. To do this, insert the transparent plate (side B facing the cra-
dle connection port) into the cradle base to cradle position P1 as shown
below. 

When accessing the data on the Flash ROM Disk, DO
NOT turn off the power, reset, or initialize the Pocket PC.

To store attachments in Inbox of Pocket Outlook, open the
application and then Tools, Options, Storage Tab. Select
Store attachments on storage card. This will store the
attachments on the Flash ROM  Disk.

Side A

Side B

Cradle 
connection port
22



Chapter 2: Basic Skills
How to Charge the Battery
You can use three charging methods.

Method 1: Connect the supplied AC adapter and the Toshiba Pocket PC
e400/e405 as shown in the figure below.

Method 2: Connect the Toshiba Pocket PC e400/e405 directly to your
computer using the supplied USB Client Cable.

Turn the unit off before connecting the AC Adapter.

Handling the cord on this product will expose you to lead,
a chemical known to the State of California to cause birth
defects or other reproductive harm. Wash hands after
handling.
23
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Method 3: Connect the supplied AC adapter and the optional cradle as
shown in the figure below, and then insert the Toshiba Pocket
PC e400/e405 into the optional cradle.

How to Prolong Battery Life
■ Use the Toshiba Pocket PC e400/e405 with the AC adapter.

Under the following conditions where the power consumption will be
high, please use the AC adapter when:

■ Operating while connected to your computer.
■ Operating with a storage card or with any other optional equip-

ment.

■ In addition, 
■ Select the short power-off time in the setting menu to shorten the

time the unit will remain on if not used (see "Customize Your
Toshiba Pocket PC" on page 41).

■ Turn off the screen light.
■ Set the screen brightness to power saving mode and shortening

the light turn-off time (see "Customize Your Toshiba Pocket PC"
on page 41).

■ Use your unit with an ambient temperature between 59°F and
77°F (15°C and 25°C). This temperature range is the most effec-
tive for the battery.

For charging the battery, maintain an ambient tempera-
ture from approx. 41°F to 104°F (5°C to 40°C).

When the lamp glows orange or green, you can use the
Toshiba Pocket PC e400/e405.

When the battery is completely charged, the Battery/
Alarm LED color will change to green.
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■ When you use the Toshiba Pocket PC e400/e405 in high or low
temperature environments, the operable time is shortened due to
the decrease of the battery capacity.

Battery Life
The built-in battery has a limited life. Repeated charging/discharging of
the battery gradually decreases operable time.

■ Do not leave the Toshiba Pocket PC e400/e405 in a place of high or
low temperature. It may shorten battery life.

Battery Charge Level and Stored Data Protection
If the battery charge level becomes extremely low, or is completely dis-
charged, the memory data stored in the Toshiba Pocket PC e400/e405
could be lost.

When the low battery status icon or the alarm message appears, immedi-
ately connect the AC adapter to the Toshiba Pocket PC e400/e405 and
charge the battery.

How to use the Optional USB Host Cable
The optional USB Host cable allows you to connect a USB keyboard to
the Pocket PC.

To connect a USB keyboard to the Pocket PC:
1. Turn off the power.

2. Plug the optional USB Host cable to the Pocket PC.

If you have not used the Toshiba Pocket PC e400/e405
for several days, its battery charge level reading may be
inaccurate. Fully recharge the battery before using.

The built-in battery gradually discharges even if the
device is not being used. When the Toshiba Pocket PC
e400/e405 is left for a long time, the built-in battery of the
Toshiba Pocket PC e400/e405 may completely dis-
charge.

As a precaution, it is recommended to save the Toshiba
Pocket PC's memory data to your computer or to a stor-
age card.

The manufacturer is not responsible for data change or
clearance due to battery discharge. 
25



Toshiba Pocket PC  e400/e405 User’s Guide
3. Connect a USB keyboard to the USB port of the optional USB Host
cable.

Initial Setup
When using the Toshiba Pocket PC e400/e405 for the first time, follow the
initial setup procedures below after the battery has been charged.

1. Move the battery switch to the “supply” position. The Toshiba Pocket
PC e400/e405 powers on automatically and the Welcome screen
appears. Tap the screen to start the following setup.

2. Execute touch screen correction.

When the align screen appears, tap the center of the cross target
with the stylus. The next target position changes upon tapping the
target. Five taps complete the positioning correction. The screen
then changes to the Stylus screen.
■ If a finger or any other object touches the screen during correc-

tion, the correction will be cancelled. Repeat the correction pro-
cedure.

3. Read how to use the stylus.

■ Read and understand the stylus operation, and then tap NEXT.

4. Learn the pop-up menu operation.

■ Read the on-screen explanation and then follow the instructions.

Charge the battery or connect the AC adapter if the bat-
tery power is low.

You cannot use a USB keyboard if the battery power is
less than 15%.

Use only a Microsoft Pocket PC compatible keyboard.

For more information on stylus operation, see "How to
Use the Stylus" on page 20.
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Display the pop-up menu, and cut and paste the data according
to the screen instructions.

■ After you finish the paste operation, this stage is completed. Tap
NEXT.

5. Set the TIME ZONE.

■ When tapping the right  mark, the city and the time zone lists
appear. Tap the desired city and time zone.

■ When the setup is completed, tap NEXT.

6. Complete the initial setup.

■ When the Complete screen appears, the initial setup is com-
pleted.

■ After tapping the screen, you can use the Toshiba Pocket PC
e400/e405.

Using a SD Card

To insert a card:
1. Turn off the power

2. Remove the dummy card.

3. Insert the card with its contact surface (metal contact surface) facing
the back of the Toshiba Pocket PC e400/e405.

4. Press down until a clicking sound is heard.

When you tap the Complete screen, the Today screen
appears. For more information on the Today screen, see
"Today Screen" on page 30.
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To remove a card:
1. Turn off the power

2. Lightly press down the card until a clicking sound is heard. The card
will pop out slightly from the slot.

3. Pull the card straight up to remove.

Connecting to a Computer
Before connecting your Toshiba Pocket PC e400/e405 to a computer,
check the following.

■ ActiveSync has been installed on your computer (see "Microsoft
ActiveSync" on page 50)

■ Make sure that the Pocket PC and your computer are both turned off.

■ The position of connecting port on the computer may differ according
to the computer type.

To connect directly using the supplied connection cable:
Connect the Toshiba Pocket PC e400/e405 directly to your computer
using the supplied USB Client cable.
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To Connect Using the Optional Cradle:
1. Connect the optional cradle to your computer as shown in the illus-

tration below.

2. Insert the Pocket PC into the optional cradle.
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Today Screen
When you turn on your device for the first time each day (or after 4 hours
of inactivity), you'll see the Today screen. You can also display it by tap-
ping  and then Today. On the Today screen, you can see at a glance
important information for the day.

Following are some of the status icons you may see.

 

Tap to view network status and options.

Tap to change the volume level or to turn the volume on/off.

Tap to change date and time.

Tap to open the owner information window.

Tap to switch to a 
program.

Your day at a glance.

Tap to disconnect from 
ActiveSync.

Tap to create a new item.

Tap and hold to change time format.
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Following are some of the status icons you may see.

Status Icon Meaning

Turns all sounds on and off

Main battery is charging 

Main battery is low 

Main battery is very low 

Main battery is full

Connection is active 

Connection is inactive

Synchronization is occurring

Notification that one or more email messages were 
received

If more notification icons need to be displayed than there
is room to display them, the Notification icon, , will dis-
play. Tap the icon to view all notification icons.
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Programs
You can switch from one program to another by selecting it from the 
menu. (You can customize which programs you see on this menu. For
information, see “Adjusting Settings,” later in this chapter.) To access
some programs, you'll need to tap , Programs, and then the program
name.

You can also switch to some programs by pressing a user programmable
button. Your device has one or more user programmable buttons located
on the front or side of the device. The icons on the buttons identify the
programs they switch to.

The following table contains a partial list of programs that are on your
device. Look on the Toshiba Pocket PC Companion CD for additional pro-
grams that you can install onto your device.

Some programs have abbreviated labels for check boxes
and drop-down menus. To see the full spelling of an
abbreviated label, tap and hold the stylus on the label.
Drag the stylus off the label so that the command is not
carried out.

Icon Program Meaning

ActiveSync Synchronize information between your 
Pocket PC and computer.

Calendar Keep track of your appointments and 
create meeting requests.

Contacts Keep track of your friends and col-
leagues.

Inbox Send and receive email messages.

Pocket Internet Explorer Browse Web sites, and download new 
programs and files from the Internet.

Notes Create handwritten or typed notes, 
drawings, and recordings.

Tasks Keep track of your tasks.

Pocket Excel 
Create new workbooks or view and 
edit Excel workbooks created on your 
computer.
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays the active
program and current time, and allows you to switch to programs and close
screens.

Use the command bar at the bottom of the screen to perform tasks in pro-
grams. The command bar includes menu names, buttons, and the Input
Panel button. To create a new item in the current program, tap New. To
see the name of a button, tap and hold the stylus on the button. Drag the
stylus off the button so that the command is not carried out.

MSN Messenger Send and receive instant messages with 
your MSN Messenger contacts. 

Pocket Word 
Create new documents or view and 
edit Word documents created on your 
computer.

Icon Program Meaning

 

 

Tap to quickly switch to a program 
you recently used.

Tap to select 
menu commands.

Tap to select 
button commands.

Tap to display the 
input panel.

Tap to switch to a program.

Tap to see more programs.

Tap to change device settings.

Tap to seea Help topic for the current screen.
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Pop-up Menus
With pop-up menus, you can quickly choose an action for an item. For
example, you can use the pop-up menu in the contact list to quickly delete
a contact, make a copy of a contact, or send an email message to a con-
tact. The actions in the pop-up menus vary from program to program. To
access a pop-up menu, tap and hold the stylus on the item name that you
want to perform the action on. When the menu appears, lift the stylus, and
tap the action you want to perform. To close the menu without performing
an action, tap anywhere outside the menu.

Notifications
Your device reminds you in a variety of ways when you have something to
do. You can be notified in any of the following ways:

■ A message box appears on the screen

■ A sound, which you can specify, is played

■ A light flashes on your device

To choose reminder types and sounds for your device, tap  and then
Settings. In the  Personal  tab, tap  Sounds & Notifications. The
options you choose here apply throughout the device.

Tap and hold to display the 
pop-up menu.

Lift the stylus and tap the 
action you want

Tap outside the menu to close 
it without performing an action.
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Enter Information on Your Toshiba Pocket 
PC
You have several options for entering new information:

■ Use the input panel to enter typed text, either by using the soft key-
board or other input method

■ Write directly on the screen

■ Draw pictures on the screen

■ Speak into your device microphone to record a message

■ Use Microsoft® ActiveSync® to synchronize or copy information from
your computer to your device. For more information on ActiveSync,
see ActiveSync Help on your computer.

Entering Text Using the Input Panel
Use the input panel to enter information in any program on your device.

You can either type using the soft keyboard or write using Letter Recog-
nizer or Block Recognizer. In either case, the characters appear as typed
text on the screen.

To show or hide the input panel, tap Input Panel. Tap the arrow next to
the Input Panel button to see your choices.

When you use the input panel, your device anticipates the word you are
typing or writing and displays it above the input panel. When you tap the
displayed word, it is inserted into your text at the insertion point. The more
you use your device, the more words it learns to anticipate.

To type with the soft keyboard:
1. Tap the  arrow and then Keyboard.

To change word suggestion options, such as the number
of words suggested at one time, tap , Settings, Per-
sonal tab, Input, and then the Word Completion tab.

Select an input method.

Input panel button.

Tap to see your choices.
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2. On the soft keyboard that is displayed, tap the keys with your stylus.

To use Letter Recognizer:
With Letter Recognizer you can write letters using the stylus just as you
would on paper.

1. Tap the  arrow and then Letter Recognizer.
2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Letter Recognizer, with Letter
Recognizer open, tap the question mark next to the writing area.

To use Block Recognizer:
With Block Recognizer you can input character strokes using the stylus
that are similar to those used on other devices.

1. Tap the  arrow and then Block Recognizer.
2. Write a letter in the box

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Block Recognizer, with Block
Recognizer open, tap ? next to the writing area.

To use Transcriber:
With Transcriber you can write anywhere on the screen using the stylus
just as you would on paper. Unlike Letter Recognizer and Block Recog-
nizer, you can write a sentence or more of information. After you finish
writing, pause and let Transcriber change the written characters to typed
characters.

1. Tap the  arrow and then Transcriber.

2. Write anywhere on the screen.

For specific instructions on using Transcriber, with Transcriber open, tap
the ? in the lower, right-hand corner of the screen.

Writing on the Screen
In any program that accepts writing, such as the Notes program, the
Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to
write directly on the screen. Write the way you do on paper. You can edit

To use larger keys, tap the  arrow, Options, select
Keyboard in Input method, and then select Large Keys.
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and format what you've written and convert the information to text at a
later time.

To write on the screen:
■ Tap Pen to switch to writing mode. This action displays lines on the

screen to help you write.

To select writing:
If you want to edit or format writing, you must select it first.

1. Tap and hold the stylus next to the text you want to select until the
insertion point appears.

2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try
again. You can also select text by tapping Pen to deselect it and then
dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with
typed text: tap and hold the selected words and then tap an editing com-
mand on the pop-up menu or tap the command on the Edit menu.

Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.

 

Tap the Pen button and use your 
stylus like a pen.
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Drawing on the Screen
You can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
select items and how they can be edited. For example, selected drawings
can be resized, while writing cannot.

To create a drawing
■ Cross three ruled lines on your first stroke. A drawing box appears.

Subsequent strokes in or touching the drawing box become part of the
drawing. Drawings that do not cross three ruled lines will be treated as
writing.

To select a drawing
If you want to edit or format a drawing, you must select it first.

■ Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect Pen and then drag to
select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding
the selected drawing and then tapping an editing command on the pop-up
menu, or by tapping the command on the Edit menu. To resize a drawing,
make sure the Pen button is not selected, and drag a selection handle.

You may want to change the zoom level so that you can
more easily work on or view your drawing. Tap Tools and
then a zoom level.

 

Pen button.

The drawing box indicates the boundaries of 
the drawing.
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Recording a Message
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording
in the Notes tab. In the Notes program, you can either create a standal-
one recording or add a recording to an existing note. If you want to add a
recording in a note, open the note first. In the Inbox program, you can add
a recording to an email message.

To create a recording:
1. If you do not see the Record/Playback toolbar, tap .

2. Hold your mobile device's microphone near your mouth or other
source of sound.

3. Tap  and make your recording.

4. Tap  when finished. If you are recording in an open note, an icon
will appear in the note. If you are creating a stand-alone recording, it
will appear in the note list.

To play a recording, tap the recording icon in the open note or tap the
recording in the note list.

You can quickly create a recording by holding down the
Record hardware button. When you hear the beep, begin
your recording. Release the button when you are finished.
The new recording is stored in the open note or as a
stand-alone recording if no note is open.

 

Indicates an embedded recording.

Tap to show or hide the Recording toolbar.

Tap to begin recording.
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert pre-
set or frequently used messages into the text entry area. To insert a mes-
sage, tap My Text and tap a message.

To edit a My Text message, tap Tools and then Edit My Text Mes-
sages.Select the message you wish to edit and make desired changes.

Find and Organize Information
The Find feature on your device helps you quickly locate information.

■ On the  menu, tap Find. Enter the text you want to find, select a
data type, and then tap Go to start the search.

You can add text after inserting a My Text message
before sending it.

To quickly find information that is taking up storage space
on your Pocket PC, select Larger than 64 KB in Type.

A next to a file name indicates the file is saved on a
storage card.

Tap to select a prewritten message.
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You can also use the File Explorer to find files on your device and to orga-
nize these files into folders. 

1. On  the  menu, tap Programs, and then select File Explorer.
2. Tap My Device, and then tap to open any folder.
3. To change folders, tap My Device, point to your folder, and then tap

to open. Tapping Name allows you to sort the folders by ascending
or descending order.

4. To create a new folder, tap and hold on the screen, and then select
New Folder from the pop-up window.

Customize Your Toshiba Pocket PC
You can customize your device by adjusting device settings and installing
additional software.

Adjusting Settings
You can adjust device settings to suit the way you work. To see available
options, tap , Settings, then the Personal or System tab located at the
bottom of the screen.

You might want to adjust the following:

■ Clock, to change the time or to set alarms

■ Menus, to customize what appears on the  menu, and to enable a
pop-up menu from the New button

■ Owner Information, to enter your contact information

■ Password, to limit access to your device

■ Power, to maximize battery life

■ Today, to customize the look and the information that is displayed on
the Today screen

Adding or Removing Programs
Programs added to your device at the factory are stored in ROM (read-
only memory). You cannot remove this software, and you'll never acciden-
tally lose ROM contents. ROM programs can be updated using special
installation programs with a *.xip extension. All other programs and data
files added to your device after factory installation are stored in RAM (ran-
dom access memory).

You can move files in File Explorer by tapping and holding
the item you want to move, and then tapping Cut or Copy
and Paste on the pop-up menu.
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You can install any program created for your device, as long as your
device has enough memory. The most popular place to find software for
your device is on the Pocket PC Web site (http://www.microsoft.com/
mobile/pocketpc).

To add programs using ActiveSync
You'll need to install the appropriate software for your device on your com-
puter before installing it on your device.

1. Determine your device and processor type so that you know which
version of the software to install. Tap  and then Settings. On the
System tab, tap About. In the Version tab, make a note of the infor-
mation in Processor.

2. Download the program to your computer (or insert the CD or disk
that contains the program into your computer). You may see a single
*.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files
for different device types and processors. Be sure to select the pro-
gram designed for the Toshiba Pocket PC e400/e405 and your
device processor type.

3. Read any installation instructions, Read Me files, or documentation
that comes with the program.

Many programs provide special installation instructions.

4. Connect your device and computer.

5. Double-click the *.exe file.

■ If the file is an installer, the installation wizard will begin. Follow
the directions on the screen. Once the software has been
installed on your computer, the installer will automatically transfer
the software to your device.

■ If the file is not an installer, you will see an error message stating
that the program is valid but it is designed for a different type of
computer. You will need to move this file to your device. If you
cannot find any installation instructions for the program in the
Read Me file or documentation, use ActiveSync Explore to copy
the program file to the Program Files folder on your device. For
more information on copying files using ActiveSync, see Active-
Sync Help.

Once installation is complete, tap , Programs, and then the program
icon to switch to it.
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To add a program to the Start menu
Tap , Settings, Menus, the Start Menu tab, and then the check box for
the program. If you do not see the program listed, you can either use File
Explorer on the device to move the program to the Start Menu folder, or
use ActiveSync on the computer to create a shortcut to the program and
place the shortcut in the Start Menu folder.

■ Using File Explorer on the device: Tap , Programs, File
Explorer, and locate the program (tap the folder list, labelled My Doc-
uments by default, and then My Device to see a list of all folders on
the device). Tap and hold the program and tap Cut on the pop-up
menu. Open the Start Menu folder located in the Windows folder, tap
and hold a blank area of the window, and tap Paste on the pop-up
menu. The program will now appear on the menu. For more informa-
tion on using File Explorer, see "Find and Organize Information" on
page 40.

■ Using ActiveSync on the computer: Use the Explorer in ActiveSync
to explore your device files and locate the program. Right click the pro-
gram, and then click Create Shortcut. Move the shortcut to the Start
Menu folder in the Windows folder. The shortcut now appears on the

 menu. For more information, see ActiveSync Help.

To remove programs
■ Tap  and then Settings. On the System tab, tap Remove Pro-

grams
If the program does not appear in the list of installed programs, use File
Explorer on your device to locate the program, tap and hold the program,
and then tap Delete on the pop-up menu.

Setting Password
You can protect data or settings from a third person by setting a password
which is requested when turning power on.

1. Tap  and then Settings. On the Personal tab, tap Password.

2. Select the type of password you would like to use.

3. Enter a password and tap OK.
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4. Tap YES on the confirmation screen. The password is saved and the
screen returns to the Personal tab screen.

To Set Screen light
You can set the screen brightness for better sight according to a place of
use. You can also set the time that elapses until the screen light turns off
automatically after the last operation.

1. Tap  and then Settings. On the System tab, tap Screen light.
2. Set the Screen light on battery power.

If you tap YES on the confirmation screen to return to the
Personal tab screen, it becomes necessary to enter the
password even for displaying the Password setting
screen. 

In case you forget the password, it is necessary to initial-
ize the Pocket PC. Please note that when initialization is
executed, data or settings stored in the Pocket PC are all
deleted.

Screen light control over the screen brightness is depen-
dent upon the battery capacity; when battery power is low,
this feature does not work.

 

Check to activate power save mode. It will 
make the screen light turn off automatically 
when the Pocket PC has not been used for 
a user-set amount of time.

Check to make the screen light turn on 
automatically when a button is pressed or the 
screen is tapped.

Set the time that elapses until the screen light 
turns off automatically.
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-or set the screen light on External power

3. Set the Brightness level

4. When finished, tap OK to return to the System tab screen.
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Setting Power
You can set to confirm the battery remaining power and the time that
elapses until the power turns off after the last operation.

1. Tap  and then Settings. On the System tab, tap Power.
2. Set the Power.

3. Select Option tab to adjust when the battery alarm will come on.

4. When finished, tap OK to return to the System tab screen.

 

Options are 1, 2,3,4, and 5 minutes until device 
will turn off in battery-powered mode if not used. 
Check box to left to engage this feature.

Options are 1, 2, 5,10, 15 and 30 minutes until 
device will turn off in external-powered mode if 
not used. Check box to left to engage this feature.

Battery alarm can be adjusted to go off from 10% to 
50% of full charge.
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Setting Memory
You can adjust the data storing memory and the program running mem-
ory. You can also confirm the free space of a storage card and so on.
Memory for the Pocket PC is managed automatically.

To change Memory allocation:

1. Tap  and then Settings. On the System tab, tap Memory to dis-
play the Memory setting screen.

2. Drag the knob right or left to adjust the memory allocation between
Storage and Program.

3. When finished, tap OK to return to the System tab screen.

To confirm usage status of a storage card:
1. Tap Storage card tab on the Memory setting screen.

2. When finished, tap OK to return to the System tab screen.

To release memory:
If memory is running short of its capacity, i.e., error message display, the
following methods are available to release the memory.

■ Transfer data to a storage card and the like and delete them from the
Pocket PC.

■ Delete unnecessary files.
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■ Quit a program in execution.

■ Delete a program not in use.

For more information on detailed operation method or the memory
release method other than the above, see online help.

Setting Advanced Sounds
This program allows you to adjust the volume of the built-in speaker and
headphone speaker on your Pocket PC. To adjust the system volume, tap
Start, Settings, Personal tab, then Sounds & Notifications.

1. Tap Start and then Settings. On the System tab, tap Advanced
Sounds.

2. Select the Built-in tab and adjust the volume of the built-in speaker.

3. Select the Tone Control tab and adjust the treble and bass.

4. If using headphones, select the Headphone tab and make adjust-
ments.

Setting Microphone
The Toshiba Pocket PC e400/e405 has three settings that adjust the built-
in microphone levels to capture the highest quality recordings: 

■ Interview—Use this when recording within 4 inches (10 cm).

■ Conference—Use this when recording over 4 inches and less than 20
inches (50 cm).

■ Custom—Use this when you want to the most control over your
recording. You can select between Auto Gain Control (AGC) and man-
ual gain settings that either increase, decrease or set a limit on the
recording level.

1. Tap Start, then Settings. On the System tab, tap Microphone.

2. Select one of the tress setting. If you select Custom, tap Configure
to adjust the recording levels. When Auto Gain Control is selected,
control over Volume, Mute and Bass is not available.
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Microphone settings can be controlled by third-party
applications.
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Microsoft ActiveSync

Using Microsoft® ActiveSync®, you can synchronize the information on
your computer with the information on your Pocket PC. Synchronization
compares the data on your device with your computer and updates both
with the most recent information. For example:

■ Keep Pocket Outlook data up-to-date by synchronizing your device
with Microsoft Outlook data on your computer.

■ Synchronize Microsoft Word and Microsoft Excel files between your
device and computer. 

Your files are automatically converted to the correct format.

With ActiveSync, you can also:

■ Change synchronization settings and synchronization schedule. 

■ Copy files between your device and PC. 

■ Back up and restore device information. 

■ Add and remove programs on your device

Before you begin synchronization, install ActiveSync on your computer
from the Toshiba Pocket PC Companion CD. ActiveSync is already
installed on your device.

After installation is complete, the ActiveSync Setup Wizard helps you con-
nect your Pocket PC to your computer, set up a partnership so you can
synchronize information between your Pocket PC and your computer, and
customize your synchronization settings. Your first synchronization pro-
cess will automatically begin when you finish using the wizard.

By default, ActiveSync does not automatically synchro-
nize all types of information. Use ActiveSync options to
turn synchronization on and off for specific information
types.
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After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You'll notice that information you've stored in
Microsoft Outlook on your computer has been copied to your device, and
you didn't have to type a word. Disconnect your device from your com-
puter and you're ready to go!

Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device. To switch to
ActiveSync on your device, tap , and then tap ActiveSync.

For information about using ActiveSync on your computer, start Active-
Sync on your computer and then see ActiveSync Help.

For more information about ActiveSync on your device, switch to Active-
Sync, tap , and then tap Help.

Tap to synchronize via IR or change 
synchronization settings.

Tap to connect and synchronize.

Tap to stop synchronization.

View connection status.

View synchronization status.
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Chapter 4:

Microsoft Pocket Outlook

Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and
Notes. You can use these programs individually or together. For example,
email addresses stored in Contacts can be used to address email mes-
sages in Inbox.

Using ActiveSync®  you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your computer with your device. You can also
synchronize this information directly with a Microsoft Exchange server.
Each time you synchronize, ActiveSync compares the changes you made
on your device and computer or server and updates both with the latest
information. For information on using ActiveSync, see ActiveSync Help on
the computer.

You can switch to any of these programs by tapping them on the 
menu.

Calendar: Scheduling Appointments and Meetings
Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and set Calendar to remind you of
appointments with a sound or other method.

To create an appointment:
1. If you are in Day or Week view, tap the desired date and time for the

appointment.

2. Tap  New.

3. Using the input panel, enter a description and a location. Tap first to
select the field. You can also tap and select available, predefined text
or locations.

4. If needed, tap the date and time to change them. 

5. Enter other desired information. You will need to hide the input panel
to see all available fields.

You can customize the Calendar display, such as chang-
ing the first day of the week, by tapping Options on the
Tools menu. 
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6. To add notes, tap the Notes tab. You can enter text, draw maps, or
create directions or recordings. For more information on creating
notes, see "Notes: Capturing Thoughts and Ideas" on page 55.

7. When finished, tap  OK  to return to the calendar (the appointment is
automatically saved).

Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is dis-
played. To change the appointment, tap Edit on the command bar.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket
Outlook. The meeting request will be created automatically and sent
either when you synchronize Inbox or when you connect to your email
server. Indicate how you want meeting requests sent by tapping Tools and
then Options. If you send and receive email messages through Active-
Sync, select ActiveSync.

To schedule a meeting:

1. Create an appointment by tapping New.

2. In the appointment details, hide the input panel, and then tap
Attendees.

3. From the list of email addresses you've entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and placed in the Outbox
folder.

For more information on sending and receiving meeting requests, see
Calendar Help and Inbox Help on the device.

Contacts: Tracking Friends and Colleagues
Contacts gives you quick and easy access to a list of your friends and col-
leagues. Using the device infrared (IR) port, you can quickly share Con-
tacts information with other device users.

If you select  Remind me in an appointment, your device
will remind you according to the options you have set.

To change the way information is displayed in the list, tap
Tools, then Options. 
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To find a contact:
1. Tap All Contacts to select the category of contacts you want dis-

played in the list.

2. Tap Find a name and enter of a name to quickly find it in the list.

3. Tap the screen to see additional phone numbers and email address for
the contact.

4. Tap on the contact to display or edit the contact details.

5. Tap and hold on the contact to display a pop-up menu of actions.

To create a contact:
1. Tap  New.

2. Using the input panel, enter a name and other contact information.
You will need to scroll down to see all available fields (use the scroll
box or scroll arrows).

3. To assign the contact to a category, scroll to and tap Categories and
select a category from the list. In the contact list, you can display
contacts by category.

4. To add notes, tap the Notes tab. You can enter text, draw maps, or
create directions or recordings. For more information on creating
notes, see "Notes: Capturing Thoughts and Ideas" on page 55.

5. When finished, tap  OK  to return to the contact list.

Finding a contact
There are four ways to find a contact:

• Tap , then Find, enter the contact name (first, last, or middle),
phone number, or address, select Contacts for the type, and then tap
Go.

• From Contacts, start typing a contact name until you see it displayed
on the screen. To show all contacts again, tap the text box at the top of
the screen and clear the text, or tap the arrow icon to the right of the
text box.

• In the contact list, tap the category list (labeled All Contacts by
default) and tap the category to which you've assigned a contact. To
show all contacts again, select All Contacts.

• To view the names of companies your contacts work for, in the contact
list, tap View, and then By Company. The number of contacts that
work for that company will be displayed to the right of the company
name.
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Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.
To change the contact information, tap  Edit and make the changes.

Tasks: Keeping a To Do List
Use Tasks to keep track of things you need to do.

1. Tap All Tasks to select the category of tasks you want displayed.

2. Tap the task to display or edit. Tapping Priority allows you to sort the
folders by ascending or descending order.

To create a task:
1. Tap  New.

2. Using the input panel, enter a description.

3. You can enter a start date and due date or enter other information by
first tapping the field. If the input panel is open, you will need to hide
it to see all available fields.

4. To assign the task to a category, tap Categories and select a cate-
gory from the list. In the task list, you can display tasks by category.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see "Notes: Cap-
turing Thoughts and Ideas" later in this chapter.

6. When finished, tap OK to return to the task list.

Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To
change the task, tap  Edit and make the changes.

Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone num-
bers with Notes. You can create a written note or a recording. You can
also include a recording in a note. If a note is open when you create the

To change the way information is displayed in the list, tap
Tools  and then  Options.

To quickly create a task with only a subject, tap Entry Bar
on the  Tools menu. Then, tap Tap here to add a new
task  and enter your task information.
55



Toshiba Pocket PC  e400/e405 User’s Guide
recording, it will be included in the note as an icon. If the note list is dis-
played, it will be created as a stand-alone recording.

To create a note:
1. Tap New.

2. Create your note by writing, drawing, typing, and recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.

Tap to create a new item.

Tap to show or hide the Recording toolbar.

Tap to record.

Tap and hold to display a pop-up menu of 
actions.

Tap to open a note or play a recording.

Tap to change the sort order of the list.
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Inbox: Sending and Receiving Email Mes-
sages
Use Inbox to send and receive email messages by synchronizing email
messages with Microsoft Exchange or Microsoft Outlook on your PC.

Synchronizing Email Messages
Email messages can be synchronized as part of the general synchroniza-
tion process. You will need to enable Inbox synchronization in ActiveSync.
For information on enabling Inbox synchronization, see ActiveSync Help
on the PC.

Tap to add a recording to the note.

Tap to show or hide the input panel.

Tap to write on the screen.

Tap to return to the note list (the note is saved 
automatically).
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During synchronization:

■ Messages are copied from the Inbox folder on your PC or Exchange
server to the Inbox folder on your device. By default, you'll receive
messages from the last three days only, the first 100 lines of each new
message, and file attachments of less than 100 KB in size.

■ Messages in the Outbox folder on your device are transferred to
Exchange or Outlook and then sent from those programs.

■ The messages on the two computers are linked. When you delete a
message on your device, it's deleted from your PC the next time you
synchronize.

■ Messages in subfolders or other email folders in Outlook are synchro-
nized only if they have been selected for synchronization in Active-
Sync.

Using the Message List
Messages you receive are displayed in the message list. By default, the
most recently received messages are displayed first in the list.

To read your messages:
1. Tap Inbox to select the service and folder you want to display.

2. Tap the message to open. Tap and hold on the message to display a
pop-up menu of actions.

3. Tapping Received Date allows you to sort the messages by ascend-
ing or descending order

4. To connect, send and receive email, tap the Send/Receive icon on
the command bar.

5. To connect to a selected account, tap the Account icon on the com-
mand bar.

To respond to a received message:
1. To reply to or forward the selected email, tap the Reply icon on the

command bar.

2. Tap OK to return to the message list.

Unread messages are displayed in bold. When multiple
messages appear, use the scroll arrows on the command
bar to view the previous or next message.

To delete a message, tap the Delete E-mail icon on the
command bar. 
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Composing Messages
To compose a new message:
1. In the message list, tap New.

2. In the To field, enter the email address of one or more recipients,
separating them with a semicolon, or select a name from the contact
list by tapping Address Book. All email addresses entered in the
email fields in Contacts appear in the Address Book.

3. Compose your message. To enter preset or frequently used mes-
sages, tap My Text and select a message.

4. Tap Send when you've finished the message. If you are working
offline, the message is moved to the Outbox folder and will be sent
the next time you connect. If you are working online, it is sent imme-
diately.

Managing Email Messages and Folders
Each email account has its own folder hierarchy with five default folders:
Inbox, Outbox, Deleted Items, Drafts, and Sent Items. The messages you
receive and send through the mail account are stored in these folders.
You can also create additional folders within each hierarchy. The Deleted
Items folder contains messages that have been deleted on the device.
The behavior of the Deleted Items and Sent Items folders depends on the

Tap to show or hide the co
header.

Tap to show/hide the recording toolbar.

.

Tap to display the Address Book.

Tap to insert common messages.

Tap to send the message.
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Inbox options you have chosen. In the message list, tap Tools and then
Options. On the Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and
then Manage Folders to create new folders. To move a message to
another folder, in the message list, tap and hold the message and then tap
Move on the pop-up menu.

Folder behavior with a direct connection to an email server

The behavior of the folders you create depends on whether you are using
ActiveSync, POP3, or IMAP4.

■ If you use ActiveSync, email messages in the Inbox folder in Outlook
will automatically be synchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync.
The folders you create and the messages you move will then be mir-
rored on the server. For example, if you move two messages from the
Inbox folder to a folder named Family, and you have designated Fam-
ily for synchronization, the server creates a copy of the Family folder
and copies the messages into that folder. You can then read the mes-
sages while away from your computer.

■ If you use POP3 and you move email messages to a folder you cre-
ated, the link is broken between the messages on the device and their
copies on the mail server. The next time you connect, the mail server
will see that the messages are missing from the device Inbox and
delete them from the server. This prevents you from having duplicate
copies of a message, but it also means that you will no longer have
access to messages that you move to folders created from anywhere
except the device.

■ If you use IMAP4, the folders you create and the email messages you
move are mirrored on the server. Therefore, messages are available
to you anytime you connect to your mail server, whether it is from your
device or computer. This synchronization of folders occurs whenever
you connect to your mail server, create new folders, or rename/delete
folders when connected.
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Chapter 5:

Companion Programs

The companion programs consist of Microsoft® Pocket Word, and
Microsoft® Pocket Excel, MSN Messenger, and Windows Media Player.

To switch to a companion program on your device, tap Programs on the
 menu, and then tap the program name.

Pocket Word
Pocket Word works with Microsoft Word on your computer to give you
easy access to copies of your documents. You can create new documents
on your device, or you can copy documents from your computer to your
device. Synchronize documents between your computer and your device
so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
and trip reports. To create a new file, tap , Programs, Pocket Word,
and then New. A blank document appears. Or, if you've selected a tem-
plate for new documents in the Options dialog box, that template appears
with appropriate text and formatting already provided. You can open only
one document at a time; when you open a second document, you'll be
asked to save the first. You can save a document you create or edit in a
variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text
Format (.rtf), and Plain Text (.txt).
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Pocket Word contains a list of the files stored on your device. Tap a file in
the list to open it. To delete, make copies of, and send files, tap and hold a
file in the list. Then, select the appropriate action on the pop-up menu.

You can enter information by working in different modes, which you select
from the View menu. For each mode, display the toolbar for that mode by
tapping Show/Hide Toolbar   on the command bar.

You can change the zoom magnification by tapping View
and then Zoom. Then select the percentage you want.
Select a higher percentage to enter text and a lower one
to see more of your document.

If you're opening a Word document created on a com-
puter, select Wrap to Window on the View menu so that
you can see the entire document.

 

Select the type of folder you want displayed 
in the list.

Tap to create a new document.

Tap and hold an item to display a pop-up  
menu of actions.

Tap to open a document.

Tap to change the sort order of the list.
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Typing Mode
Using the input panel, enter typed text into the document. For more infor-
mation on entering typed text, see "Enter Information on Your Toshiba
Pocket PC" on page 35.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the
mouse to drag through the text you want to select. You can search a doc-
ument to find text by tapping Edit and then Find/Replace.

 

Tap and hold to see a pop-up menu of 
actions.

Tap to change formatting options.

Tap to show or hide the toolbar.

Tap to format text.

Tap to return to the document (changes 
are saved automatically).
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide, and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see "Enter Information on Your Toshiba
Pocket PC" on page 35.

If you cross three ruled lines in a single stylus stroke, the
writing becomes a drawing, and can be edited and manip-
ulated as described in the following section. Written
words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document
on your computer.

Tap to highlight selected text.

Space button.

Pen button.

With Space button selected, drag to insert 
space.
An arrow appears showing the space 
direction and size.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after the first stroke,
you'll see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Recording Mode
In recording mode, embed a recording into your document. Recordings
are saved as .wav files. For more information on recording, see "Record-
ing a Message" on page 39.

For more information on using Pocket Word, tap  and then Help.

 

Tap to select formatting options, such as pen 
weight, line/font color and fill color.

 

Tap an arrow to see your choices.

Pen button.

Resize an object by dragging the selection 
handles.
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Pocket Excel
Pocket Excel works with Microsoft Excel on your computer to give you
easy access to copies of your workbooks. You can create new workbooks
on your device, or you can copy workbooks from your computer to your
device. Synchronize workbooks between your computer and your device
so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs. To create a new file, tap , Programs, Pocket Excel, and
then New. A blank workbook appears. Or, if you've selected a template for
new workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided. You can open only one
workbook at a time; when you open a second workbook, you'll be asked
to save the first. You can save a workbook you create or edit in a variety of
formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open it. To delete, make copies of, and send files, tap and hold a
file in the list. Then select the appropriate action from the pop-up menu. 

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View and then
Toolbar.

 

Zoom button.

Format button.

AutoSum button.

Cell contents appear here as you enter them.
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Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:

■ View in full-screen mode to see as much of your worksheet as possi-
ble. Tap View and then Full Screen. To exit full-screen mode, tap
Restore.

■ Show and hide window elements. Tap View and then tap the elements
you want to show or hide.

■ Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View and then Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and col-
umn labels visible as you scroll through a sheet.

■ Split panes to view different areas of a large worksheet. Tap View and
then Split. Then drag the split bar to where you want it. To remove the
split, tap View and then Remove Split.

■ Show and hide rows and columns. To hide a hidden row or column,
select a cell in the row or column you want to hide. Then tap Format,
then Row or Column, and then Hide. To show a hidden row or col-
umn, tap Tools, then Go To, and then type a reference that is in the
hidden row or column. Then tap Format, then Row or Column, and
then Unhide.

For more information on using Pocket Excel, tap  and then Help.

If your workbook contains sensitive information, you can
protect it with a password. To do so, open the workbook,
tap Edit, and then Password. Every time you open the
workbook, you will need to enter the password, so choose
one that is easy for you to remember but hard for others
to guess.
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MSN Messenger
MSN Messenger on your mobile device provides the same chat environ-
ment as MSN Messenger on your PC. These features include: 
• Seeing who is online.

• Sending and receiving instant messages. 

• Having an instant message conversation with a group of contacts. 

• Telling contacts that you are unavailable. 

• Blocking contacts from seeing your status or sending you messages.

To use MSN Messenger, you must have a Microsoft Passport™ account
or a Microsoft Exchange email account. You must have a Passport to use
MSN Messenger Service. If you have a Hotmail® or MSN account, you
already have a Passport. Once you have obtained either a Microsoft
Passport or a Microsoft Exchange account, you are ready to set up your
account.

To switch to MSN Messenger, tap ,  Programs, and then tap  MSN
Messenger.

Setting Up
Before you can use MSN Messenger, you must set up the instant mes-
saging account(s) to use. For MSN Messenger Service, you must have a
Microsoft Passport or Hotmail account. For Exchange Instant Messaging,
you must have an Exchange account.

To set up an account and sign in:

1. In the Tools menu, tap Options and then Accounts tab.

2. Select Enable MSN Messenger Service and/or Enable Exchange
Instant Messaging.

3. Enter your sign-in name and password for the selected account(s).

4. If you selected both accounts, under Sign in using this account
first, select which account to sign in to first.

You must have your Toshiba Pocket PC e400/e405 con-
nected to a PC through the provided USB cable or
optional cradle in order for MSN Messenger to function.

Sign up for a Microsoft Passport account at 
http://www.passport.com. Get a free Microsoft Hotmail
email address at http://www.hotmail.com.
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5. To sign in, tap the sign-in screen and then Sign in.

Working with Contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an email, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

If you already use MSN Messenger on your computer,
your contacts will show up on your device without being
added again.

To see others online without being seen, in the Tools
menu, tap My Status and select Appear Offline. 

If you block a contact, you will appear offline but will
remain on the blocked contact’s list. To unblock a contact,
tap and hold the contact, then tap  Unblock  on the pop-
up menu. 

Tap a contact to start a chat.TT

Tap and hold to display a pop-TT
up menu of actions.

p p
69



Toshiba Pocket PC e400/e405
Chatting with Contacts
Tap a contact name to open a chat window. Enter your message in the
text entry area at the bottom of the screen, or tap My Text to enter a pre-
set message, and tap Send. To invite another contact to a multi-user chat,
in the Tools menu, tap Invite and tap the contact you want to invite.

To switch back to the main window without closing a chat,
tap Contacts. To revert back to your chat window, tap
Chats and select the person whom you were chatting
with.

Enter message.

Tap to send message.TT
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To know if the contact you are chatting with is responding, look for the
message under the text entry area.

For more information on using MSN Messenger, tap  and then  Help.

View full chat.

View status of the chat.
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Windows Media Player
Use Microsoft Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to
Windows Media Player for Pocket PC, tap , Programs, and then tap
Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video files to your Pocket PC. You can play Windows
Media and MP3 files on your Pocket PC.

For more information about using Windows Media Player for Pocket PC,
tap , and then tap Help.

Tap to play or pause.

Tap to stop.

Tap to play a previous song.

Tap to skip to the next song.

Tap to adjust volume.

Indicates the progress of the
current track.
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Chapter 6:

Pocket Internet Explorer

Use Microsoft® Pocket Internet Explorer to view Web pages in either of
these ways:

■ During synchronization with your computer, download your favorite
links and mobile favorites that are stored in the Mobile Favorites sub-
folder in Internet Explorer on the computer.

■ Connect to an Internet service provider (ISP) or network and browse
the Web. To do this, you'll need to create the connection first, as
described in "Get Help on Connecting" on page 79.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap  and then Internet Explorer.

The Mobile Favorites Folder
Favorites are stored in the Mobile Favorites subfolder of Favorites in Inter-
net Explorer on the PC. This folder was created when you selected the
Favorites information type for synchronization in ActiveSync on your PC.
Favorites must be stored in this folder to be synchronized.

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites
folder on your computer is synchronized with Pocket Internet Explorer on
your device. Both computers are updated with changes made to either list
each time you synchronize. Unless you mark the favorite link as a mobile
favorite, only the link will be downloaded to your device, and you will need
to connect to your ISP or network to view the content. For more informa-
tion on synchronization, see ActiveSync Help on the computer.
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Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your computer,
you can download mobile favorites to your device. Synchronizing mobile
favorites downloads Web content to your device so that you can view
pages while you are disconnected from your ISP and computer.

Use the Internet Explorer plug-in installed with ActiveSync to create
mobile favorites quickly.

To create a mobile favorite:
1. In Internet Explorer 5 or greater on your PC, browse to the page you

want to view offline.

2. Click Tools and then Create Mobile Favorite.

3. To change the link name, enter a new name in the Name box.

4. In the Update box, select a desired update schedule to keep the
page in the Mobile Favorites folder up to date. 

5. To save the link in a subfolder of Mobile Favorites, click Create In
and select the desired subfolder.

6. Click OK. Internet Explorer will download the latest version of the
page.

7. To download the pages that are linked to the mobile favorite you just
created, in Internet Explorer on the PC, right-click the mobile favorite
and then click Properties. On the Download tab, specify the num-
ber of links deep you want to download. To conserve device memory,
only go one level deep.

If you did not specify an update schedule in step 4, you
will need to manually download content to keep the infor-
mation updated on your computer and device. Before
synchronizing with your device, in Internet Explorer on
your computer, click Tools and then Synchronize. You
will see the last time content was downloaded to the com-
puter, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your
computer, click View, Toolbars, and then Customize.
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To save device memory
Mobile favorites take up storage memory on your device. To minimize the
amount of memory used:

■ In the settings for the Favorites information type in ActiveSync options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the device. For more information, see ActiveSync
Help.

■ Limit the number of downloaded linked pages. In Internet Explorer on
the computer, right-click the mobile favorite you want to change and
then Properties. In the Download tab, specify 0 or 1 for the number
of linked pages you want to download.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personal-
ized content and thousands of popular Web sites. You subscribe to
AvantGo channels directly from your device. Then, you synchronize your
device and computer, or connect to the Internet to download the content.
For more information, visit the AvantGo Web site.

Synchronize an AvantGo channel
1. In Pocket Internet Explorer on your device, tap  to display your list

of favorites.

2. Tap the AvantGo Channels link.

3. Tap Activate.

4. Follow the directions on the screen. You will need to synchronize
your device with your PC and then tap My Channels to complete the
AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your
list of favorites to see a few of the most popular channels. To add or
remove channels, tap the Add or Remove link.
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Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting to
the Internet. You can also connect to the Internet through an ISP or a net-
work connection and browse the Web.

Home button

Refresh button

Favorites button
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To view mobile favorites and channels:
1. Tap Favorites to display your list of favorites.

2. Tap the page you want to view.

You'll see the page that was downloaded the last time you synchronized
with your computer. If the page is not on your device, the favorite will be
dimmed. You will need to synchronize with your computer again to down-
load the page to your device, or connect to the Internet to view the page.

To browse the Internet:
1. Set up a connection to your ISP or corporate network using Connec-

tions, as described in "Get Help on Connecting" on page 79.

2. To connect and start browsing, do one of the following:

■ Tap Favorites, and then tap the favorite you want to view.

■ Tap View and then Address Bar. In the address bar that appears
at the top of the screen, enter the Web address you want to visit
and then tap . Tap the arrow to choose from previously entered
addresses.

To add a favorite link while using the device, go to the
page you want to add, tap and hold on the page, and tap
Add to Favorites.

Tap to add or delete a folder or favorite link.

Tap the favorite you want to view.
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Chapter 7:

Getting Connected
You can use your device to exchange information with other mobile
devices as well as your computer. You have the following connection
options:

■ Use the infrared (IR) port on your device to send and receive files
between two devices. If this is the method you want to use, see the fol-
lowing section "Transferring Items Using Infrared".

■ Connect to your computer to synchronize remotely. Once connected,
you can synchronize information such as your Pocket Outlook infor-
mation. If this is the method you want to use, see ActiveSync Help on
your computer or Connections Help on the device.

Transferring Items Using Infrared
Using infrared (IR), you can send and receive information, such as con-
tacts and appointments, between two devices.

To send information:

Switch to the program where you created the item you want to send and
locate the item in the list.

Align the IR ports so that they are unobstructed and within a close range.

Tap and hold the item, and tap Beam Item on the pop-up menu.

To receive information:
1. Align the IR ports so that they are unobstructed and within a close

range.

2. Have the owner of the other device send the information to you. Your
device will automatically receive it.

You can also send items, but not folders, from File
Explorer. Tap and hold the item you want to send, and
then tap Beam File on the pop-up menu.
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End a Connection
■ When connected via cable or cradle, detach your device from the

cable or cradle.

■ When connected via Infrared, move the device away from the PC.

Get Help on Connecting
■ Online Help on the Pocket PC. Tap  and then Help. Tap View, All

Installed Help, and then Inbox or Connections.

■ ActiveSync Help on the computer. In ActiveSync, click Microsoft
ActiveSync Help on the Help menu.

■ For troubleshooting information, see the PocketPC Web site at: 
http://www.microsoft.com/mobile/pocketpc.
79



Toshiba Pocket PC  e400/e405 User’s Guide
Chapter 8:

Optional Functions

Home
You can launch built-in or installed applications (programs) by tapping an
icon displayed on the Home screen. It can display a list of running pro-
grams, and easily activate or stop a specific program. The Home screen
displays the remaining battery power, Today information and frequently
used setting icons, and can be personalized by changing the background
or by adding icons and tabs.

Launching an Application From the Home Screen
1. Tap Start, Programs, and then Home to display the Home screen.

2. Tap the application icon you want to launch. The selected application
starts up. 

You can also launch Home by pressing the Home  but-
ton.

Launching applications: you can launch an application by
moving the cursor or scroller button to select and pressing
the center of the cursor button to confirm.
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About the Home Screen
The default Home screen is the parallel display style with information win-
dow display.

About the Information Window
The information window displays the remaining battery power, hardware
information and Today information such as today’s tasks and appoint-
ments.

Displays the date and time. Tap to display the Clock setting screen

Displays the number of current tasks as of today and the number of tasks finished 
or soon to be finished as of today. Tap to launch Tasks.

Displays the number of unread mail and the sender of the latest unread mail. Tap 
to launch Inbox.

Displays today’s next appointment. Tap to launch Calendar.

1st window.

Information window.

Tab selection box.
Tap this to switch between tabs.

2nd window.

The information can be displayed/
hidden.

The display style can be switched 
between parallel and tab.
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About Running
The Running tab displays the active application names. The icons do not
appear.

Display item Name Description

Power Tap to display the Power setting screen.

Memory Tap to display the Memory setting screen.

Screen light Tap to display the Screen light setting 
screen.

System Information Tap to display the system information.

Volume ON/OFF

Tap to toggle volume ON/OFF.
This icon is interlocked with the display of 
volume ON/OFF that has been switched 
using the icon on the navigation bar.
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Application Activate/Stop:
Tap the application name you want to activate or tap and hold the applica-
tion name and select Activate in the pop-up menu.

To display the Running tab pop-up menu, tap and hold
any portion of the screen other than the application name.
In this case, only the Stop All is selectable.

Tap to activate the selected application.

Tap to quit the selected application. When finished, 
the application name disappears.

Tap to quit all running applications displayed in the 
Running tab.

You can select the View menu or the Tools menu 
on the Running tab screen. You can select Text 
color or Background color from the View menu, 
or About from the Tools menu respectively.
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Display Icon List
The following list shows the tabs and icons for the initial setup.

Tabs Icons Applications Tabs Icons Applications

Running - - Programs File Explorer

Main Pocket 
Internet 
Explorer

DataBackup

Windows 
Media Player

MSN 
Messenger

Notes Pocket Word

Tasks Pocket Excel

Inbox Calculator

Calendar Solitaire

Contacts Jawbreaker

World Clock
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Moving Application Icons
You can move icons in tabs or between tabs. To create a new tab, see
"Tab Settings" later in this chapter.

To move icons in tabs:
1. Drag and drop the desired icon to the desired position with the icon

in a tapped state. When the icon is moved, the icon near where the
icon is to be moved is highlighted. When the icon is dropped, the
icon is moved to the position of the highlighted icon. If there is no
highlighted icon when the icon is dropped, the icon is moved to the
end of the icons.

To move icons to another tab using the pop-up menu:
1. Tap and hold the icon you want to move to display the pop-up menu.

2. Tap Cut on the pop-up menu.

3. Tap the destination tab, then tap and hold any portion other than the
icon, and then tap Paste on the pop-up menu. The selected icon is
pasted next to the last icon on the tab screen.

To move icons to another tab using drag and drop:
1. Tap the icon you want to move.

2. Drag the icon to the destination tab, and then drop it. The name of
the destination tab is displayed inverted, the icon is moved, and that
icon in the original tab screen is deleted.

Deleting an Icon
1. Tap and hold the icon you want to delete to display the pop-up menu.

2. Tap Drop on the pop-up menu. The icon is deleted and the next icon
automatically shifts to fill the deleted icon position.

When “Icons are sorted as launched order (for all tabs)” is
selected in “Tab Settings” screen, icons in tabs are sorted
in the order that they are launched. Icons cannot be
moved in tabs when this is set.

An icon cannot be moved into a tab that already includes
18 icons.

Icons that can be moved are displayed inverted when they
are tapped. The moved icon is placed next to the last icon
on the tab screen. An icon cannot be moved into a tab that
already includes 18 icons.
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Adding an Icon
You can add the application and your file icons to the Home screen.

1. Tap Edit and then Add to display the Add Application screen.

You can also select Add from the pop-up menu displayed by tapping
and holding any portion other than the icon.

2. Tap  on the Application file box to show the file list. If you cannot
locate the file, find it by tapping Browse. To refer to all folders and
files, tap Browse to show the Browse screen. When the file is
selected, its name is displayed in the Application file box.

3. Enter the icon name (up to a maximum of 32 characters) in the Appli-
cation name box that is to be displayed on the Home screen. 

4. When finished, tap OK to close the Add Application screen, and the
new icon is  added to the Home screen.

Renaming Icons
You can rename icons (applications).

1. Tap and hold the icon to rename. The pop-up menu is displayed.

2. Tap Rename from the pop-up menu. The icon can be renamed.

If the Application file is not designated, or if the Applica-
tion name is not entered, you cannot add a new icon.

You cannot launch the icon added from the storage card,
if the same card is not inserted in the Toshiba Pocket PC
e400/e405.

Tap to designate a folder you want to browse. 
When a storage card is inserted, files or folders 
contained in the storage card are displayed from 
the top directory.

Tap to move to one upper directory folder above 
the currently displayed one.

Tap to select application or file type.

If a file is selected from the list, the screen returns to 
the Add Application screen.
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3. Change the name using the input panel, and tap the screen. This
fixes the new name. 

Switching Icon Display
When icons are displayed in tab display style, their display can be
switched from the View menu. Select Large Icon or Small Icon to suit
your preference.

Tab Settings
On the Tab Settings screen you can add, delete, or rename a tab as well
as select a bitmap image to display on the screen background.

To add a  tab:
1. Tap Tools, and then Tab Settings.

2. Tap New to display a box to enter the new tab name.

3. Enter a new tab name (up to a maximum of 10 characters). When
finished, tap OK to return to the Tab Settings screen. 

4. Tap OK on the Tab Settings screen to return to the Home screen. A
new tab is added to the right of the existing tab.

To delete a tab:
1. Tap Tools, and then Tab Settings.

The number of tabs can be increased to 10. The tab order
cannot be re-arranged.

Small Icon View Large Icon View
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2. Select the tab name to delete, and then tap Delete. The Delete tab
confirmation dialog box appears. Please note that all the icons con-
tained in the same tab will also be deleted.

3. Tap Yes on the Delete tab dialog to delete the tab. When finished,
the screen returns to Tab Settings screen.

4. Tap OK on the Tab Settings screen to return to the Home screen.

To change the name of a tab:
1. Tap Tools and then Tab Settings.

2. Select the tab name you want to change, and then tap Modify.

3. Enter a new tab name (up to a maximum of 10 characters). When
finished, tap OK to return to the Tab Settings screen. 

4. Tap OK on the Tab Settings screen to return to the Home screen.

To sort icons:
Icons in tabs can be sorted in the order that they were last launched.

1. Tap Tools and then Tab Settings.

2. Select the “Icons are sorted as launched order (for all tabs)” check
box.

3. Tap OK on the Tab Settings screen to return to the Home screen. 

To change a background:
1. Tap Tools and then Tab Settings.

2. Select the tab name you want to change, and then tap Modify.

3. Tap Browse. The Browse screen is displayed. Even if a storage card
is inserted, the files in the storage card will not be displayed.

4. To return to the previous screen, tap the desired bitmap file from the
list.

5. To return to the Tab Settings screen, tap OK.

You cannot delete the Running tab.

You cannot rename the Running tab.

To move icons in a tab, clear the check box.
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6. Tap OK on the Tab Settings screen to return to the Home screen.

Background Color and Text Color Setting
You can use Background Color to select a color for the background for
each tab. Additionally, Text Color is available to apply a color for the appli-
cation name for each tab.

To apply Background Color and Text Color:
1. Tap Tools and then Tab Settings.

2. Select the tab name you want to change, and then tap Modify.

3. Tap Background color or Text color to display the color list.

4. Select the color, and tap OK to return to the previous screen.

5. To return to the Tab Settings screen, tap OK.

6. Tap OK on the Tab Settings screen to return to the Home screen.

Using DataBackup
Periodical backup of your data is highly recommended. You can make a
backup of the Toshiba Pocket PC e400/e405 data to a storage device.
Additionally, if you have backed up your data on a storage device, you can
restore that data in your Toshiba Pocket PC e400/e405 as well as delete
backup file data from the storage device. 

Data of the following three types can be backed up:

File: Includes a file created by Pocket Word, Pocket Excel, Notes, or an
additionally installed program.

Registry: Settings information on Windows Mobile 2003 or built-in pro-
grams.

Database: Microsoft Pocket Outlook information.

If the selected file is not a designated file type, you cannot
set it on your screen background. The Home screen
image display range is 240 pixels (W) x 268 pixels (H).

When a background image is set, the background image
will stay intact and not change even if a background color
is set. Note, however, that if the image does not com-
pletely fill the background, the background color will form
a border around the image. Background color and text
color can also be set from the View menu.
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Making a Backup
Before performing the backup or restore operations, do the following;

• Check that there is enough space in the main unit’s memory and on
the storage device. If the storage device does not have enough free
space, you cannot save the backup data. The backup data is saved as
a file named backup.dat on your storage device.

• Make sure the main unit’s power is off when loading and unloading the
SD card.

• Save current data in the main unit’s memory before backing it up on
the storage device.

1. To make a backup to the SD card, insert a SD Card. Make sure to do
so in the proper direction.

2. Tap Start, Programs, and then DataBackup to display the DataBackup
screen shown below.

1. Data such as the password in Settings cannot be
restored.

2. The data stored in the Flash ROM disk cannot be
backed up.

3. Before backing up or restoring data, stop other appli-
cations, and connect the AC adapter to the Toshiba
Pocket PC e400/e405.

4. If you make a backup to the SD card or Flash ROM
Disk using the DataBackup Utility, please DO NOT
remove the SD card, reset the device, and/or turn off
the device’s power until the backup is completed.

5. If you restore the data from the SD card or Flash
ROM Disk by DataBackup Utility, please DO NOT
remove the SD card, reset the device, and/or turn off
the device’s power until the restore is completed.

Failure to follow any of the above procedures may result
in the loss of data.
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3. Tap Backup from Functionality, and select the storage destination.

4. Tap Start. The screen for confirming that other applications have
ended appears.

5. To display the Backup password input screen, tap OK.
6. Enter a password. You can enter a password up to a maximum of 16

characters. Backup can be made even without entry of a password.
If a password is entered, that password is required at the time of
restore.

7. When finished, tap OK. The progress bar is displayed during the
backup process. When the backup is completed, the backup finish
message appears. The backup time that is displayed on screen is
the time that the backup was started.

8. Tap OK to return to the previous screen.

If you forget the password, you cannot restore the backup
data. Do not forget your password. Write down the pass-
word and keep it in a safe place where only you know.

Tap to select:
All: All files stored in the main memory, 
registry, and database. 
PIM data: Pocket Outlook data (Con-
tacts, Calendar, and Task).
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9. Tap Exit to close the DataBackup screen.

Carrying Out the Restore Operation
To restore is to overwrite the backed up data from the storage device onto
the main memory of your Toshiba Pocket PC e400/e405. Prior to restoring
your data, please consider the following:

• If the same file name exists in the main memory of your Toshiba
Pocket PC e400/e405, this file data is replaced with the backup data
from the storage device.

• If files exist in the main memory but not in the backup file, they will not
be overwritten.

1. To restore from the SD card, insert the SD card that contains the
backup data into your Toshiba Pocket PC e400/e405.

2. Tap Start, Programs, and then DataBackup to display the
DataBackup screen shown on the following page.

If storage device does not have enough free space, the
backup process will not start. Before starting the backup,
check the remaining storage device capacity.

If the storage card is write-protected, you cannot save the
backup data. Cancel the write-protection before starting
the backup.

Backups can also be made periodically. For more infor-
mation, see "Making an Auto Backup", later in this chap-
ter.

Backup files are always overwritten.
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3. Tap Restore from Functionality, and select the storage destination.

4. Tap Start. The screen for confirming that other applications have
ended appears.

5. Tap OK to display the Restore password input screen.

6. Enter the password used when backing up the data (if the file was
previously created without a password, then a password is not
required).

7. When finished, tap OK. The progress bar is displayed during the
restore process. When the restore is completed, the restore finish
message appears.

8. Tap OK. Your Toshiba Pocket PC e400/e405 is now reset and it will
automatically restart.

If your Toshiba Pocket PC e400/e405 memory becomes
short of its capacity during restore, the restore process
stops. Increase the memory allocation of the main mem-
ory of your Toshiba Pocket PC e400/e405 (see "To save
device memory"), and then restart the restore procedure.

Data backed up on a legacy model Toshiba Pocket PC or
another manufacturer’s Pocket PC (simply called “other
Pocket PC” from here on) cannot be restored to your
Toshiba Pocket PC e400/e405. To load other Pocket PC
data to your Toshiba Pocket PC e400/e405, use Active-
Sync to synchronize the personal computer with the
other Pocket PC. Next, synchronize the personal com-
puter with Toshiba Pocket PC e400/e405, and then load
the data to Toshiba Pocket PC e400/e405.

Tap Restore.

Tap to select the storage destination.
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Deleting a Backup File
You can delete a backup file and replace it at another time or make room
for more data on your Toshiba Pocket PC e400/e405.

To delete the backup data: 
1. Insert the SD Card into your Toshiba Pocket PC e400/e405.

2. To display the Backup screen, tap Start, Programs, then
DataBackup.

3. Tap Delete Backup File from Functionality, and select the storage
destination.

4. Tap Start.
5. To delete the backup file, tap OK.

6. Tap Exit to close to the DataBackup screen.

Making an Auto Backup
You can set up your Toshiba Pocket PC e400/e405 to automatically
backup files at a specified time intervals. Select the backup time, occur-
rence, and frequency that best suits your needs. 

To make a backup automatically: 
1. Insert a SD Card

2. To display the DataBackup screen, tap Start, Programs, then
DataBackup.

3. Tap Auto backup settings from the Tools menu. The Settings
screen is displayed.

4. Set the desired items.

Select Run an auto backup.

If required, enter a password.
Tap to select the storage destination.

Select if power backups are required.
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5. Tap OK. The settings data is saved, and makes periodical backups
at the preset time.

6. Tap Exit to close to the Backup screen.

Setting the World Clock
World Clock displays the time and date of multiple cities in a screen. You
can select the cities easily, by tapping the map or pull-down list.

If the Run Auto backup only when power is off check box
is clear, the auto backup confirmation screen will be dis-
played if your Pocket PC is ON when the auto backup
occurs. The backup will be automatically started if you tap
OK or about 30 seconds elapses after the confirmation
screen is displayed. Tap Cancel to stop the backup.

If the Run Auto backup only when power is off check box
is clear, the message screen will be displayed, and the
backup will be started after about 10 seconds if your
Pocket PC is off when the auto backup occurs.

Auto backups will only occur if the AC Adapter is con-
nected or the remaining battery charge is 50% or more.

You can confirm whether or not auto backups have
occurred by checking when the last backup was made.
Depending on the conditions, auto backups may not
occur.

Auto backups will not occur if the preset storage card is
not inserted in the card slot at the specified auto backup
time.

Do not turn your Toshiba Pocket PC e400/e405 off during
an auto backup. Doing so might damage the data or your
Toshiba Pocket PC e400/e405.

If the storage device runs out of data storage space dur-
ing an auto backup, the backup will end midway. Before
an auto backup is made, check the amount of free space
on the storage device.
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1. Tap Start, Programs, and then World Clock.

2. Tap Tools. 

3. Select any of the following: 

• Select from map: A zoomed map is displayed on the screen.
You can select a city and assign to Home or others, by tapping on
the map. (For detail, refer to the next page.)

• Alarm: Alarm setting is displayed. You can set alarm, or arrange
the detail settings.

• About: The version information is displayed.

To select the city from a zoomed map:
1. Tap Select from map from Tools menu. 

2. Select the city by tapping on the zoomed map. The information of the
selected city is displayed.

3. Select Home, City1, or City2 from the pull-down list.

4. Tap OK.

TOSHIBA Voice Recorder (TVR)
The TOSHIBA Voice Recorder (TVR) is a media player for TOSHIBA
Pocket PCs. TVR offers a flexible way to record your voice as a .wav file.
It can also play the recorded .wav on a PC.

DST (Daylight Saving Time) is applied automatically.

Home

daytime

nighttime

City2

City1
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To use TVR to record:
1. Tap Start, Programs, and then TOSHIBA Voice Recorder.

2. Tap Record button. Your Pocket PC starts recording a clip immedi-
ately.

3. Tap Stop button to stop recording. File names listed as “TVRMMD-
DYYYYHHMMSS.wav”. These are in the date (DD/MM/YEAR
HH:MM:SS), length (HH:MM:SS) and quality (LP/HQ) format.

To play a file from the TVR:
1. On the TVR screen, tap on the clip name.

2. Tap Play button. You can also play the file by scrolling with the scrol-
ler then pressing the scroller.

3. Tap Stop button to stop.

You can toggle between time recorded and time available
to record given storage in current media at the current
record quality level.

You can tap on the time display to toggle between time
played and time left to play.

Clips recorded on the TVR can be played on computers
with Windows 200 and Windows XP operating systems
with Windows Media Player.

Enable/disable AGC for 
built-in microphone.

Recording rate 
information

Play/Record time 
information

Select pre-set or custom 
microphone gain settings.

Microphone gain control, 
when Custom AGC Settings.

Tap to set optional settings.

Tap to change quality mode 
HQ (High Quality) or 
LP (Long Play).

Tap to display version information.

Tap and hold to 
display a pop-up 
menu of actions.
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The TVR offers several convenient features: 

■ Pre-set mic gain—You can preset the mic gain level to best suit vari-
ous recording conditions by selecting either Conference, Interview, or
Custom.

■ AGC—If the Automatic Gain Control (AGC) is enabled, the slider is
disabled.

■ Microphone gain slider—This is available when Custom is selected
at pre-set mic gain and AGC is disabled.

■ Delete or Rename a clip—To delete or rename a clip, tap and hold
the clip, then select the function from the pop-up menu.

■ Send a clip—You can send a clip by tapping and holding the clip.
From the pop-up menu, select Send via E-mail or Beam File.

To set the TVR options: 

1. On the TVR screen, tap the Settings icon .

■ You can assign TOSHIBA Voice Recorder to the hardware recording
button if the Assign TVR to Record button check box is selected.
You can play the .wav files recorded with Notes if Play all WAV files
with TVR is selected.

■ You can choose the folder to save a recording file. 

If you assign TVR to Record button, TVR starts every
time you push the Record button, instead of starting
Microsoft original recording function.

The files recorded with TVR cannot be played with Notes.
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Using Text to Speech
TOSHIBA Text to Speech for Pocket PC (simply called Text to Speech
from here on) synthesizes voice, and reads out emails, text files and text
data on the clipboard. Text to Speech consists of three applications, Mail
Speech, Text Speech and Speech Settings. 

Mail Speech displays unread emails and reads them out. Text Speech
picks up text files in Toshiba Pocket PC e400/e405 and reads them out. It
also reads out text data on clipboard. Speech Settings arranges the set-
tings of Mail Speech and Text Speech. You can use one application of
Text to Speech at a time. Please exit the current one to start another appli-
cation.

You can also read out your tasks, unread mails, or appointments from
Home. Tap your tasks, unread mails, or appointments in the Information
Window of Home.

To setup Text to Speech from Companion CD:
1. Make sure your Pocket PC is connected to your computer and that

an ActiveSync connection has been established.

2. Start the Text to Speech installation by running the Setup program.

3. Check your Toshiba Pocket PC e400/e405 screen for any additional
steps required to complete the installation.

Mail Speech

To start Mail Speech:
1. Open the Inbox, and set the mail account you want to read out

2. Tap Start, Programs, then Mail Speech.
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Mail Speech starts reading the message from the header information of
unread email list. As the reading continues, the currently read phrase is
highlighted.

3. Select any of the following:

• Play: Starts reading out the text of the selected email.
• Pause: Stops reading. If you tap Play again, continues reading

the text.
• Stop: Stops reading the text.
• Exit: Exits Mail Speech.

4. Tap Tools. Select any of the following:

• Refresh: Refreshes the status of the email database.
• Settings: Starts the Speech Settings.
• Exit: Exits the program.
• About: Displays the version information screen.

Account name displays here.

Selected email text displays here.
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5. Tap and hold the selected words to display the pop-up Copy menu. 

Text Speech
Text Speech reads a text file and the data stuck on the clip board.

To read out a text file:
1. Tap Start, Programs, then Text Speech.

If you tap a mail header in the unread email list while
reading, it starts reading selected email.

Mail information displayed in the mail header information
area is descending order, that is the older mails are on
the top and newer mails are shown in the lower area.

When there is an attached file, the voice service
announces, “with attached file”. It does not announce the
“TO” or “CC” of a mail header.

While reading an email, DO NOT synchronize your
Toshiba Pocket PC e400/e405 with the PC.

The text may not be displayed correctly depending on the
mailer of the sender. US ASCII (us-ascii) and 8-bit West-
ern Europe (iso-8859-x) character code are supported. 

This application supports base 64, quoted-printable and
non-encoded. If the text is encoded, it cannot to be dis-
played. UUENCODE is not supported. When the text is
longer than 2k bytes, the part over 2k bytes is not read.
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2. From the Tools of the command bar, tap Open. The list of the text
files stored in your Pocket PC e400/e405 and storage device is dis-
played.

3. Select any of the following:

• Folder: Select the folder from the pull-down menu.
• Cancel: Close the file selection screen and return to the Text

Speech screen.
• Type: Only text file (*.txt) is available.
• File list: Display Name, Folder, Date, Size, Type and Location.

The file to read should be under \My Documents.
4. Tap the file you want read. The text is displayed.

5. Select any of the following:

File list.

Text area.

Reading status.
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• Play: Starts reading the text.
• Pause: Stops reading. If you tap Play after Pause, it will start

from the position where it was paused. 
• Stop: Stops reading. If you tap Play after Stop, it will start from

the beginning of the text. 
• Exit: Exits the program.

To read the text copied on clipboard:
Copied data on clipboard can be read by Text Speech, including data from
Pocket Internet Explorer or Pocket Word.

1. Within Pocket Internet Explorer, copy the text data to the clipboard.

2. Tap Start, Programs, then Text Speech. If the Text Speech applica-
tion is already opened and a text data is displayed on text area, tap
and hold the text, then Clear All from the pop-up menu.

3. Tap and hold the text area, then select Paste from the pop-up menu.
The data on the clipboard is displayed on text area.

4. Tap Play.

Speech Settings
To start Speech Setting, tap Start, Programs, then Speech Settings. You
can also start Speech Settings by tapping Tools, then Settings on the
Mail Speech or the Text Speech screen.

You can input text directly in the text area, using the Input
Panel 

The maximum size of a text file or clipboard data to be
read is 16,000 characters. Text Speech begins reading
from the cursor position.
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Reading Tab

Select any of the following:

• Tone: Changes the tone of the voice (default value: 0).
• Speed: Changes the reading out speed (default value: 0). 
• Default Value: Reset all values to the default.
• Not read more than 2/3 marks: If selected, the continuous

marks on the text are skipped when reading out. You can define
the skipping case (continuous 2 or 3 marks) from the pull-down
list.

Mail Tab

■ The reading mail turns into a read: Once selected, the status of the
reading changes from read to unread.
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■ Check at least one of the following: Read the name of the sender,
Read the subject, Read the date of receipt, or Read the message.

■ After reading wait for: Sets the time interval for reading the following
mail. To read the message while this setting is available, tap the mes-
sage area within the interval time. This message is only available
when the Read the message check box is cleared.

■ Default Value: Resets all the values to the default.

Using Voice Command
With Voice Command, you can operate your Pocket PC “hands free” with-
out tapping or pressing buttons on your Toshiba Pocket PC e400/e405.

The Voice Command application has three components:

■ Global Command: the command always available

■ User Command: the command that users can assign freely, always
available.

■ Command for each application: Command available only for the
foreground windows.

Installing the Voice Command
1. Make sure your Toshiba Pocket PC e400/e405 is connected to your

computer and that an ActiveSync connection has been established.

2. Start the Voice Command installation by running the Setup program.

3. After the program is installed successfully, a message displays to
inform you that the application has been allocated to the Program
button 5 (recording button) automatically. 

4. After installation, the system requires resetting.

The Voice Command cannot “read” without the TOSHIBA
Text to Speech for Pocket PC installed. Installation of the
Toshiba Text to Speech for Pocket PC is highly recom-
mended. 

Once Voice Command is installed on your Toshiba Pocket
PC e400/e405, the Program button 5 (recording button at
initial setting) is “assigned” and recording with Program
button 5 is no longer available. If you want to use Program
button 5 for recording while the Voice Command is
assigned, change the button assignment by tapping Start,
Settings, and then Buttons.
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Setting Up Voice Command
Once installed on your Toshiba Pocket PC e400/e405 the Voice Com-
mand Settings icon is displayed on Today screen. Tap this icon to launch
the Voice Command Settings application.

Global Command
1. Press the recording button and release immediately. The Voice Com-

mand starts. Wait for a notification sound to start speaking.

2. Say one of the available voice commands. For example, to launch
Inbox, say “run Inbox”.” When the command is successfully recog-
nized, a confirmation tone sounds, and the Inbox screen appears. If
the command is not recognized, a rejection tone sounds and the
screen does not change.

User Command
You can define voice commands on Command Settings. 

There are two kinds of commands:

• Commands to insert texts

• Commands to launch applications.

To use the commands to insert texts:
1. On the User Commands tab in the Voice Command Settings, define

a phrase you like to a command. For example, define “Thank you for
your email about” for the command insert text one.

2. Open the Inbox, then tap New from the command bar. At the creat-
ing the message screen, say “insert text one.” The “Thank you for
your email about” is displayed on the screen.

Tap to launch Voice Command Settings.
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To use the commands to launch applications:
1. On the User Commands tab in the Voice Command Settings, assign

an application you like to a command. For example, assign Solitaire
to the command Run program one.

2. Say “run program one.” The Solitaire screen is displayed.

Using Voice Command for Each Application
For example, you can use voice commands in the Calendar application.

1. With the Calendar open, say “very next appointment.” The listing
mode screen appears, and it starts reading out very next appoint-
ment. You can display the screen also by saying, “move to listing
mode.” For detail of the command list, refer to the Commands tab on
the Voice Command Settings.

2. In listing mode, voice command for Calendar is active to current
focused appointment. For example, saying “read subject” reads the
subject of current focused appointment.

For other commands, you can check the command from the Commands
tab of the Voice Command Settings.

When you say an undefined command, nothing happens
even if the command is recognized.

The target term of appointment is one month before to
one month after, based on current time.

Tap to stop reading.
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Voice Command Settings
You can check the voice command list or arrange the settings of voice
command. To start the Voice Command Settings, tap Start, Programs,
and then Voice Command Settings.

Checking the Command List
On the Commands tab, you can check the all commands installed.

To define the action for a User Command:
1. Tap the User Commands tab on the Voice Command Settings

screen.

Displays information for the selected command.

Tap Tools and then About to display Voice Command 
Settings version information.
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To define text for the command:
1. Tap and hold the command insert text xxx, then select Edit.

2. Input the text you want to define at the text area. For example, input
“Thank you for your email about”. 

3. Tap OK.

To assign a program to the command:
1. Tap and hold the command run program xxx, then select Edit.
2. Select the application you want to assign by tapping Browse.

You can only clear the action for the command.  The com-
mand is not deleted.

Tap to clear the action that you 
defined for the command.
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3. Tap OK.

Arrange the Recognition Level of Voice Command
1. Tap Settings on the Voice Command Settings screen.

2. Set the recognition level as required. The higher level of recognition
that is set, the more sensitive the program is to the nuances of your
voice, and it makes it easier for your Toshiba Pocket PC e400/e405
to recognize the command. On the other hand, setting a higher level
of recognition may decrease voice recognition within noisy environ-
ments. It is recommended to set the recognition level lower than nor-
mal within noisy environments.

Enter the parameter specific to the application.

Tap and select the recognition level (1 to 5).
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System Information
The System Information program displays the system information such
as CPU clock, CPU stepping, Boot Loader Version, OS Version, PIC Ver-
sion, and UUID. The information is displayed by accessing the Identity,
Memory, Drivers, and System tabs.

To launch the program, tap Start, Settings, System, and then System 
Information.

Identity Tab
The opening menu presents identification information for product 
service.

Memory Tab
The Memory tab presents information about the systems RAM, ROM, and
Flash ROM Disk.

Drivers Tab
The Drivers tab displays the drivers used by the system’s software appli-
cations.

System Tab
The System tab displays CPU, operating system, and other system infor-
mation.
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Tools Menu
The Tools menu displays the system information and allows it to be
exported to a text (*.txt) file. Export exports all system information param-
eters to a text (*.txt), and About displays the system information version.
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Chapter 9:

Additional Information

Troubleshooting
Check the following guide for the possible cause of a problem and how to
correct it.

Symptom Cause Correction

The power button is 
pressed but the power 
does not turn on.

The built-in battery 
power is exhausted.

Charge the battery.

The power was 
suddenly cut off.

The built-in battery 
power is exhausted.

Charge the battery.

Automatic suspend is 
active.

Select , Settings, 
System tab, Power to 
set to alter the power 
shut down time.

Even if the built-in 
battery is completely 
charged, it discharges 
after a short period of 
time.

The built-in battery 
cannot hold a charge.

Replace the main 
battery with a new one.

The screen was 
tapped, but no correct 
action was not 
executed.

Touch screen 
adjustment is incorrect.

Select , Settings, 
System tab, Align 
Screen to adjust the 
touch screen. If the 
screen alignment loses 
calibration it may not 
be possible to adjust 
alignment using the 
above method. In that 
case, the Align Screen 
command can be 
executed by 
simultaneously 
pressing the power 
button and scroll 
button.
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The screen was 
tapped, but there is no 
response. The 
operation button does 
not work either.

Unresponsive 
operating  system

Reset the system. If no 
action is observed after 
resetting the system, 
initialize the system. 
(NOTE: YOUR DATA 
WILL BE DELETED.)

The screen is dark. The screen light is off. Press and hold the 
power button until the 
screen light is turned 
on or touch the screen 
with the stylus.

The screen is hard to 
see.

Brightness setting is 
incorrect.

Select , Settings, 
System tab, Screen 
light to adjust the 
screen brightness for 
better sight.

Can not connect to 
your computer.

- See Help of 
ActiveSync.

ActiveSync does not 
function when your 
Pocket PC is 
connected to your 
computer with a USB 
cradle or USB cable.

The USB driver of your 
computer may not be 
compatible.

Reselect the USB 
driver.

Following message is 
displayed. "NOT 
ENOUGH BATTERY 
POWER. USB devices 
cannot be used. 
Because PDA's bat-
tery power is low" 

The battery power is 
too low to use USB 
devices.

Charge the battery or 
connect AC adapter. 

Following message is 
displayed. "TOO 
MUCH USB 
CONNECTION. 
Connecting USB 
devices are too much."

The total power 
consumption of 
connected USB 
devices is too large.

This USB port supports 
total 500 mA USB 
device. Confirm 
connected USB device.

Symptom Cause Correction
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Resetting
Reset is equal to “restart” of a computer. Carry out when pressing a button
or tapping the screen does not respond. When your Toshiba Pocket PC
e400/e405 is reset, all data that was not stored during operation will be
deleted. Stored data will be saved.

■ When the power is on, press the reset button with the stylus, then
release.

Following message is 
displayed. "USB OVER 
CURRENT DETECT 
USB device is turned 
off. Please disconnect 
USB device." 

The total power 
consumption of 
connected USB 
devices is too large. 

This USB port supports 
total 500 mA USB 
device. Confirm 
connected USB device. 

To enable USB port 
again, turn off the 
power of Pocket PC or 
push the reset button. 

If the function cannot be restored even if the reset button
is pressed, initialize your Toshiba Pocket PC e400/e405.

Symptom Cause Correction
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Initializing
When you initialize your Toshiba Pocket PC e400/e405, it returns to the
status when it was purchased.

1. Turn off the power.

2. Press the power button while pressing and holding the reset switch
with the stylus, and then release the power button.

3. When a screen appears, release the reset switch. When initialization
is completed, the Welcome screen appears. Set up the system
according to the screen as in the case of startup procedure.

When you initialize your Toshiba Pocket PC e400/e405,
all data stored in the memory is deleted. Your Toshiba
Pocket PC's initially installed programs are not deleted.

Before initialization, remove all storage cards.
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Specifications
External dimensions Approximately: 

4.9 in. (125 mm) x 3.0 in (76 mm) x 0.49 in. (12.5 mm) (L x W x H)

Operating conditions Temperature: 32°F to 104°F (0°C to 40°C), Humidity: 30% to 
80% Relative Humidity, when only the Pocket PC is operating
Temperature capable of charging: 41°F to 104°F (5°C to 40°C)

Battery type Lithium-Ion battery

Processor Intel® PXA261 Processor at 300 MHz 
CPU performance in your computer product may vary from 
specifications under the following conditions:
• use of certain external peripheral products
• use of battery power instead of AC power
• use of certain multimedia games or videos with special effects
• use of standard telephone lines or low speed network connec-

tions
• use of complex modeling software, such as high end com-

puter aided design applications
• use of computer in areas with low air pressure (high altitude 

>1,000 meters or >3,280 feet above sea level) 
• use of computer at temperatures outside the range of 5°C to 

35°C (41°F to 95° F) or >25°C (77°F) at high altitude (all tem-
perature references are approximate).

CPU performance may also vary from specifications due to 
design configuration. Under some conditions, your computer 
product may automatically shut-down. This is a normal protec-
tive feature designed to reduce the risk of lost data or damage 
to the product when used outside recommended conditions. To 
avoid risk of lost data, always make back-up copies of data by 
periodically storing it on an external storage medium. For opti-
mum performance, use your computer product only under rec-
ommended conditions. 

Memory RAM: 64 MB, ROM: 16 MB

Flash ROM Disk 32 MB

Display 3.5" TFT Color LCD, 240 pixels x 320 pixels, up to 64K colors 

Interfaces

DC-IN 5V/2A

Headphone 3.5 mm, stereo, mini-plug compatible

SD card slot SD memory card, SDI/O card or Multimedia card. 
Note: The security function of the SD memory card is  not 
usable. Data encrypted by the SD memory card security func-
tion-compatible equipment is not usable.

Infrared port Based on IrDA ver.1.3
Maximum data transmission speed: 115 kbps.

Cradle connection port USB Host/Client
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1

Although the display is manufactured using an extremely high order of
technology, there may be a case that some dots do not light or always
light. It is not a malfunction.

Audio AC 97 codec, monophonic record, stereophonic playback, 
8.0 khz, 11.025 khz, 22.05 khz, and 44.1 khz sample rates. Full 
duplex record and playback. On board microphone. On board 
speaker. Stereophonic earphone jack, software volume and 
tone controls. 

Options AC adaptor, USB Client cable, USB Host cable, stylus pen, 
cradle.
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